Some Basic Rules

1. There must be at least one qualified operator present at all times while the telescope is in use.
2. Two people should be present at all times for safety reasons.
3. In the event of a personal emergency, dial 911 immediately and worry about the telescope later. Please use the emergency contacts listed on the phone list in the control room to let others know about the emergency.
4. No smoking anywhere on UofM property, including the roof.
5. No food or drink in the dome. Please use caution in the control room and roof, and do not leave trash on the roof.
6. Access for the public or for classes is through the stairwell and roof door. Access for people who cannot climb stairs is through the lift in AH5190. Do not bring groups into the control room or up the spiral stair.
7. Keep the control room door closed to prevent anyone from wandering in while you’re in the dome. Keep the door at the top of the spiral stair closed to prevent drafts.
8. Do not leave the dome open or the telescope running and unattended (except to go open the doors for your class). Do not leave the roof access doors open unless there is someone on the roof.
9. Do not open or close the dome with the telescope uncovered.
10. Check the white board for telescope status and information before starting up the ‘scope.
11. Always check the date and time before running the tcs program.
12. SCHEDULING and instrument changes: Classes get highest priority for use, followed by scheduled open observing (class or public). All use must be arranged around classes and open observing. Student research projects get priority over other events for instrument changes, but scheduled events take priority over unscheduled use. In general, M–Th until 10 PM is reserved for classes, Fridays until midnight for SAS.
13. NEVER point the telescope at the Sun since serious damage WILL result. If using the ‘scope during daylight hours, keep the shadow of the dome on the ‘scope to prevent accidentally allowing too much light into the optics.
14. If you do anything in the dome or with the 0.4-m, enter it in the log book.
# Table of Contents

**SOME BASIC RULES**

**QUICK GUIDE: STARTING UP**  
Control Room  
Dome Opening  
Aligning the Telescope  

**QUICK GUIDE: SHUTTING DOWN**  
Stowing the Telescope  
Closing the Dome  
Control Room Shut Down  

**RESTARTING**

**HARDWARE**

Eyepiece  
Rotator  
Sidewinder  
Using the CCDs and Spectrograph  

**THE TELESCOPE CONTROL SYSTEM**

Overview of the System  
Using the TCS Software  
Controlling the Telescope Without TheSky  

**HANDPADDLE OPERATIONS**

Focus  
Moving the Telescope  
Dome Rotation  

**THESKY**

Opening  
Linking  
Appearance  
Controlling the Telescope With TheSky  
Exiting TheSky  

**FIRST TIME SETUP**

Setting up the Observatory Windows Computer  
Web Browser Home Page  
Setting up the Box Client  
Setting Up TheSky  
Setting up CCDSoft  

**SETTING UP THE CCDS AND SPECTROGRAPH**
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up CCDSofT for Imaging</td>
<td>28</td>
</tr>
<tr>
<td>Capturing the Image</td>
<td>33</td>
</tr>
<tr>
<td>Shutting Down the Camera</td>
<td>34</td>
</tr>
<tr>
<td><strong>The SGS Spectrograph</strong></td>
<td>35</td>
</tr>
<tr>
<td>SGS Manual Adjustments</td>
<td>35</td>
</tr>
<tr>
<td><strong>Troubleshooting</strong></td>
<td>37</td>
</tr>
<tr>
<td>Issues With the Dome</td>
<td>37</td>
</tr>
<tr>
<td>Telescope Pointing Problems</td>
<td>40</td>
</tr>
<tr>
<td>Problems With Telescope Motions</td>
<td>43</td>
</tr>
<tr>
<td>Telescope Limits</td>
<td>46</td>
</tr>
<tr>
<td>Other Problems</td>
<td>47</td>
</tr>
<tr>
<td><strong>Appendix 1: History and Comparison with Other Michigan Telescopes</strong></td>
<td>50</td>
</tr>
<tr>
<td><strong>Appendix 2: Technical Information for the 0.4-M</strong></td>
<td>51</td>
</tr>
<tr>
<td>Telescope Description</td>
<td>51</td>
</tr>
<tr>
<td>Location</td>
<td>51</td>
</tr>
<tr>
<td>Optical Characteristics</td>
<td>51</td>
</tr>
<tr>
<td>Eyepieces and Instruments for the 0.4-M</td>
<td>52</td>
</tr>
<tr>
<td><strong>Appendix 3: Filters</strong></td>
<td>52</td>
</tr>
<tr>
<td><strong>Appendix 6: The Messier Objects and Their Coordinates</strong></td>
<td>53</td>
</tr>
<tr>
<td><strong>Appendix 7: Operator’s Exam</strong></td>
<td>55</td>
</tr>
<tr>
<td>Reporting Trouble</td>
<td>59</td>
</tr>
</tbody>
</table>
Quick Guide: Starting Up

If you have not run the 0.4-m since September 2013, please go to First Time Setup on page 22.

Control Room

1. Check the whiteboard for any notes on the telescope status. If it indicates that the pointing model has been updated since your last use, please go to setting up TheSky on page 24.
2. Enter the date, time, and your name in the logbook.
3. Log in to the Windows PC.
4. Get the current UT from the Windows PC. There is a link to the USNO clock on the observatory home page (see page 23.)
5. Turn on the power strip on top of the blue electronics box. The telescope control system (tcs) computer will boot.
6. Once you have a prompt type DATE. If the date is correct, hit <Enter>. Otherwise, enter the correct date. Remember this computer runs on UT, so the date changes at 0:00 UT, not local midnight.
7. Type TIME to check the time. If the time is correct, press <Enter>. Otherwise, enter a time 5 – 10 seconds ahead of the current time, then press <Enter> when the UT clock actually reaches that time. Use either military/24 time or include “a” or “p” to indicate AM or PM. Being a little fast is better than being slightly slow.
8. Type tcs to start the Telescope Control System software.
9. On front of blue box, throw the following switches:
   a. MTR DRIVER CHASSIS up.
   b. Red HALT MOTORS out (press in to unlatch this).
   c. DRIVES up.
   d. TRACK up
   e. TRACK/AUX TRACK to TRACK (up – it should already be in this position)

   All other switches should be down. There are white dots on the top row of switches to indicate the operating position.
10. On the PC, open TheSky. Make sure a TPoint model loads (see page 20.)
11. In the “Telescope” menu, click on “Link > Establish”. A white cross hair cursor should appear at the center of the screen to indicate where the telescope is pointing. If not, see the trouble shooting section, page 41.
12. Head upstairs.
Dome Opening

1. Check the weather and the roof for obstructions, including possible snow and ice on the dome in cold months. Do not open the dome if there is anything that could possibly fall on the telescope, or if it is very (>90%) humid.

2. Turn on the power strip on the desk to turn on the desk lamps.

3. Open the vents and turn on the ventilation fan switch to “HAND” (the control is located on the south wall, behind the “Hot 240” sign). Note you can do this early in the day to get the ‘scope cooled off for better seeing.

4. Make sure the cover is still on the telescope and finder scope, and the dome rotation power cord is not plugged in.

5. Remove the cord from the shelf with the dome shutter controls and plug it into the outlet below the shelf.

6. Push the upper shutter switch to open the upper shutter. It will stop automatically when fully open.

7. Once the upper shutter is about 1 m open, push the drop out shutter switch left to turn on the hydraulics. Pull down on the handle on the far left side of the shelf to open the drop out shutter.

8. The hydraulics will squeal when the drop out shutter is all the way open. Release the handle and turn off the drop out shutter switch.

9. Once the upper shutter has stopped, turn off the switch and unplug the shutter controls. Be sure the cord is securely placed on the shelf so it cannot fall down while the dome is rotating.

10. Grab the cord sitting on the vent under the north side of the dome and plug it in.
**Aligning the Telescope**

1. Turn on the power strip on the desk if it isn’t already on. This should turn on the monitors and the red desk lamp.

2. While the telescope is still upright, remove the finder cap and eyepiece plug and put the 35 mm eyepiece in (see page 9.) Use the handpaddle (see page 19) and slew the telescope down until you can reach the cover from the stepladder. Do not slew due north since there is no software limit under the pole.

3. On the tcs, select item 2 Movement Menu (see page 13.)

4. Select item 3 Select Library Object (see page 17.)

5. Determine what number to select: Check the sidereal time “S. T. hh mm ss” on the tcs display and round to the nearest hour. Add 401 to get the library object number, E.g. if the sidereal time is 21h 57m, round the ST to 22h and add 401 so the library object number will be 423.

6. Enter the library object number from the previous step and press <Enter>.

7. Answer “No” to “Any Changes?” The coordinates will appear as the “Next Object” and “Slew enabled” will blink at the bottom of the screen.

8. Select item 7 Start slew and press <Enter> to slew the telescope to the object.

9. Rotate the dome if necessary (see page 19.)

10. Center the star first in the finder scope then in the main telescope using the handpaddle (see page 19.) If no star is visible, check the sky (make sure it is clear and dark enough), or see There is nothing visible in the telescope in the troubleshooting section on page 41.

11. Hit <ESC> on the tcs to go back to the main menu.

12. Select item 1 Initialization Menu (see page 12.)

13. Select item 2 Set telescope position.

14. Enter “0” for all values. Answer “No” to “Any Changes?”

15. Hit <ESC> on the tcs to go back to the main menu, and then select 2 Movement Menu.

16. Make sure the Windows computer has a dark theme enabled. Open KnightVision and make the screen red (see page 22).

17. The telescope is now ready for observing. You may need to repeat this process if the telescope tracking gets off for any reason.

18. Turn off the ventilation fan (it vibrates the ’scope.)
Quick Guide: Shutting Down

**Stowing the telescope**

1. Remove the eyepiece and put the eyepiece plug in the 1.25” adapter in the eyepiece port. Put the cover on the finder 'scope. If necessary, use the handpaddle to slew the telescope to a position where you can reach the front end of the telescope from the step stool. Do not lean or pull on the telescope tube while putting the cover on. Do not slew it under the pole (due north).

2. Shut down any other equipment, such as the CCD (see page 34.)

3. In TheSky, go to Telescope → Link → Terminate.

4. Exit TheSky (see page 21 about saving.) Close KnightVision. You can log out of the PC now, or leave it running if you have other applications open.

5. On the tcs, select Movement Menu item 5 Set zenith position. It will warn you this sets all track rates to zero and ask “Any changes?” Tell it “NO”, then select 7 Start slew and press <enter> to move it to the zenith position.

6. Check the levels to make sure the telescope really is level. If necessary, use the handpaddle to make adjustments.

7. Close the dome (see below).

8. Close all vents and the outside roof doors, turn off the power strip and lights (check lamp(s) not on power strip), and head downstairs.

**Closing the Dome**

1. All optics must be covered before proceeding.

2. Rotate the dome to its home position, facing roughly NE. Make sure the shelf isn’t too close to the stairs, and that the cord will reach the outlet.

3. Unplug the dome rotation power cord and place it on top of the vent.

4. Take the cord down from the shelf and plug it in.

5. Move the upper shutter switch to the right to start the upper shutter closing.

6. Move the drop out shutter switch left and push the lever up to raise the drop out shutter. Note the drop out shutter will not close if the upper shutter is too low. If you cannot get the drop out shutter to close, try opening the upper shutter.

7. Release the lever when the hydraulics squeal, indicating it is fully closed.

8. Turn off the drop out shutter switch.

9. The upper shutter will stop when it is closed. Turn off the upper shutter switch.

10. Unplug the shutter control cord and place it securely on the shelf. Do not leave the dome plugged in when not in use.

11. If you didn’t already, close the vents and doors and turn off the power strip and lights.
Control Room Shut Down

1. On the front of the blue electronics box throw the following switches:
   a. TRACK off (down)
   b. DRIVES off (down)
   c. Red HALT MOTORS in all the way.
   d. MOTOR DRIVER CHASSIS off (down.) – the halt motors and horizon limits lights will go off.
   e. Make sure TRACK / AUX TRACK is on TRACK (up.)

2. Turn off the power strip (there is no graceful way to exit the tcs program, so you do not need to do anything to the tcs computer before this.)

3. Exit TheSky and LOG OFF the PC if you did not do so upstairs.

4. In the logbook, enter the date (if it changed), time, and any comments.

5. Make sure all the lights are off (check the spiral stair light!)

Restarting

If the telescope gets pushed, the tcs crashes, or the hardware limits are hit, you will need to restart the telescope.

1. In TheSky, go to Telescope → Link → Terminate.

2. If you can move the telescope: (if not, skip to the next step)
   a. Select Movement Menu item 5 Set zenith position to get the telescope close to upright
   b. Use the handpaddle and the spirit levels to get the telescope aligned on zenith. Be as precise as possible.

3. In the control room, throw the switches as in step 1 in the Shutting Down - Control Room, immediately above.

4. Lift the flap on the blue box, and press the Reset button to reboot the tcs computer.

5. Type tcs to start the tcs software. Check the UT and U Date to make sure they are still correct. See page 12 if you need to update them.

6. If you were able to move the telescope to zenith in step 2, go to step 9 under Quick Guide: Starting Up - Control Room on page 4. Finish those steps, then go through Aligning the Telescope on page 6.

7. If you could not move the telescope to zenith before restarting, go to step 9 under Quick Guide: Starting Up - Control Room on page 4 but DO NOT turn the TRACK switch to on. Use the handpaddle to move the ‘scope to zenith. DO NOT use “Set Zenith position”, because the computer now thinks the tipped over position is the zenith. Once you’re at zenith, repeat steps 3 - 6.
Hardware

Except when work is being done, there is a permanently mounted instrument package, consisting of a rotator, Sidewinder (instrument selector/flip mirror), USB (new) CCD imager with filter wheel, 1.25” eyepiece adapter, and SGS spectrograph with parallel (old) CCD imager. The diagram below shows the location of each instrument.

IMPORTANT: NEVER FORCE ANYTHING TO MOVE. Everything that is supposed to move should move easily and smoothly. Many parts are screwed together, so if you do force something to move, you could actually un-mount it.

Eyepiece

There is a 1.25” adapter ring with one setscrew to hold the eyepieces. Make sure you are using this single setscrew when changing eyepieces, not the setscrews holding the adapter or extension tube. It is a good idea to check those other four setscrews at the beginning of the night to make sure they are tight.

To insert an eyepiece, remove the orange eyepiece plug, slip the eyepiece shaft into the black 1.25” adapter, and tighten the single set screw on the adapter. To switch eyepieces, loosen the single set screw on the 1.25” eyepiece adapter, slip the current eyepiece out, put the new eyepiece in, and tighten the setscrew.

Rotator

Two important rules: always hold the Sidewinder to rotate the instrument package, NOT one of the instruments, and watch the cables. The CCD power cords in particular aren’t really long enough for all positions.

A hex head setscrew holds the rotator in place.

Loosen the setscrew, rotate the sidewinder, and then tighten the setscrew using the hex wrench tied to the pier.
**Sidewinder**

The Sidewinder has a plane mirror inside that can be flipped to send light to the eyepiece, the imaging CCD, or pulled out of the way to allow light to go to the spectrograph. Two setscrews lock the mirror in place.

To rotate the mirror:

1. Loosen the setscrews and pull the mirror adjustment knob out about 1/8” (~0.3 cm). It sort of clicks into place, but it’s a little stiff so it is easy to pull it just a little too far.

2. Turn the knob until the mirror position indicator is in the right position (see below.) If it won’t rotate, try moving the knob in or out a little bit. Once it is pulled into position, it rotates easily.

3. Push the knob in and lock it.

To allow light to go through to the bottom port, loosen the setscrews and pull the knob all the way out. Lock the setscrews.
Using the CCDs and Spectrograph

There are 2 imagers attached (see page 9 for a picture.) Both are SBIG ST-8 CCDs with built-in autoguiders. You should go through the first instructions for setting up CCDSoft on page 27 before using them. Instructions for using the software to capture the images are on page 28.
Instruments are now permanently mounted, with the exception of maintenance. See Sidewinder on page 10 for instructions on sending the light to each instrument. Note that while it is possible for the computer to talk to both imagers at once, light can only go to one instrument at a time.

USB (New) CCD

The new, USB CCD is mounted to the back port on the Sidewinder and has a SBIG CFW-8 filter wheel installed. Open CCDSoft and check your settings before turning the power on (see page 28.)

![USB CCD]

The power switch is on the back of the top power inverter on the telescope pier.

When the power is on, there is a green lamp on the front of the inverter, and a red lamp on the CCD.

Normally, the fan will also be on, but it is possible to turn off the fan without turning off the power.

More detailed information on this camera is available at [http://ftp.sbig.com/sbwhtmls/ST8XME.htm](http://ftp.sbig.com/sbwhtmls/ST8XME.htm)

Parallel (Old) CCD and SGS

The old, parallel CCD is installed as the imager for the spectrograph. Information on the SGS hardware is in the SGS manual adjustments section on page 35.

Open CCDSoft and check your settings before turning the power on (see page 31.)

It is plugged into the power strip mounted to the side of the pier. When it is on, there is a red lamp on the CCD, and you can hear the fan running. The switch on the power strip will also be lit.

![Parallel CCD]
The Telescope Control System

Overview of the System

This telescope is completely under computer control: one never moves it or the dome by hand except in an emergency. The computer hardware and software combination that control the telescope and dome are called the Telescope Control System (TCS). Commands are sent to the TCS by means of the left hand keyboard in the dome or in the control room. It is possible to do all of the observing from the control room and never be in the dome.

The tcs display is shown below. The top 2 sections display information such as the current pointing, UT and Sidereal time, and focus position. The Rates area indicates the current settings for the tracking and handpaddle rates. Status shows what the computer thinks the switches on the blue box are set to. Terminal is the area where you interact with the tcs. A description of the menus follows.

The Menus

In all menus, 0 (zero) will take you back to the main menu. <ESC> will take you up one level. Changes made through the tcs menu are NOT saved when the tcs computer is rebooted.

Initialization Menu

1. Set date and time
   - Set the date and time for the tcs software. See Setting the Date and Time on page 15.
2. Set telescope position
   - Tell the tcs the coordinates the telescope is pointing to. Entering zero will cause the tcs to use the coordinates under NEXT OBJECT, which is usually the last set of coordinates entered. See Aligning the Telescope on page 6.
3. Set dome position
   - NA – the encoders are not connected. Tells the tcs where the dome is pointed. See Aligning the Dome on page 16.
4. Set rotator position
   - NA - our instrument rotator is not motorized.

5. Set focus position
   - **Not Recommended**: causes the tcs to crash. Change the numerical value of the focus reading.
   - See Also: Miscellaneous Menu item 4: Move focus position on page 14; Focusing under Using the TCS software on page 15; and Focus under Handpaddle Operations on page 18.

6. Open data file
   - NA (A DOS formatted floppy is required to get the data off the tcs.) For instructions on capturing the observing data with the image, see page 27.

7. Close data file
   - NA

**Movement Menu**

1. Set slew position
   - Tells the tcs what coordinates you want to point to. Requires RA, Dec and epoch. See Manual entry of coordinates: on page 17

2. Set offset
   - Tells the tcs to move the telescope to a position relative to the current position. See Starhopping on page 18

3. Select library object
   - Select an item from the Sommers-Bausch Observatory Catalog of Astronomical Objects. See Using library objects on page 17. See Also Aligning the Telescope on page 6.

4. Select table entry
   - If you created a table using Miscellaneous menu item 3 (page 14), you can use this command to select an entry.

5. Set zenith position
   - Move the telescope to what the tcs thinks is zenith and sets the track rates to 0 so the telescope stops tracking. See Stowing the telescope on page 7.

6. Start trail
   - Turns on the trail function. Used to move an object back and forth across the slit in a spectrograph. Set the speed, length and angle using the rates menu (below). See Also The SGS Sectrograph on page 34.

7. Start slew
   - Makes the telescope move to the coordinates under NEXT OBJECT if “SLEW ENABLED” is blinking.

8. Stop
   - Overrides telescope motion. See Stopping the telescope on page 14.

9. Write data to file
   - NA – See page 27 for instructions on capturing observing data in CCDSoft.

**Rates Menu**

1. Set Track Rates
   - Set the tracking and auxiliary tracking rates. See also Setting the rates on page 16.
   
   The track rate is the speed at which the telescope moves in order to track an object. This rate also determines the slew rate. The sidereal rate is 15.000 for RA, and 0 for Dec. The AUX TRACK rates let you set a temporary rate, as might be needed for a comet. If the switch on the blue box is set to AUX TRACK, this is the rate used by the telescope. The default rate is 0 for both RA and Dec.
2. Set handpaddle rates
   - Adjust the SET RATE (the speed the telescope will move when holding the SET button on the handpaddle) or GUIDE RATE (the speed the ‘scope moves if only the direction button is pushed.) See Moving the Telescope under Handpaddle Operation on page 19.

3. Set trail rates
   - Set the speed for using the trail function (see Start Trail under the movement menu above)

Miscellaneous Menu
1. Set switches
   - NA - Allows software adjustment of rates to keep the apparent handpaddle and dome tracking rates constant regardless of where the telescope is pointed. Requires other setup.

2. Set display epoch
   - Change the display epoch (default is now)

3. Set table entries
   - Build a table of up to 40 objects, which can then be selected from Movement menu item 4. You need the RA, Dec and epoch for each object. You need a DOS formatted floppy to move the table on and off the tcs computer.

4. Move focus position
   - Adjust the focus to a specific position. See the table on page 52 for approximate positions. See also Focus under Handpaddle Operations on page 18.

Using the TCS software

Stopping the telescope

Movement menu item 8 “Stop” will:
   - stop the telescope in mid-slew.
   - clear the coordinates and prevent the telescope from slewing if “start slew” is blinking.
   - override the handpaddle, but only as long as the buttons are pressed.

See also, Movement under the tcs menu descriptions on page 13. Item 8 does not stop the telescope from tracking, and it will not prevent the telescope from tracking into the limits.

To stop the telescope tracking, do one of the following:
   - set the Track switch on the front of the blue box to OFF;
   - use movement menu item 5, set zenith position (see Stowing the telescope step 5 on page 7); or
   - set the track rate to 0 (see Setting the Rates on page 16.)
Pointing and Moving the Telescope

The normal way to move the telescope to a new object is with TheSky (see page 21.)

There are also several ways to move the telescope with just the tcs. For all these options, see Controlling the Telescope without TheSky on page 17. However, the best pointing will be achieved using TheSky with a TPoint model (see page 20.)

Small adjustments such as centering are usually done with the handpaddle (see page 19.)

If you are trying to shut down or restart the telescope (page 8), use movement menu item 5 to get back to what the tcs thinks is zenith, then use the handpaddle to adjust the levels.

Setting the Date and Time

The time needs to be accurate for accurate pointing and so the computer knows where the software limits should be. Differences of more than several seconds should be corrected. Being slightly fast is better than being slow because the telescope tracking will trigger the software limits too early rather than too late. The tcs uses UT, which is EST + 5h or EDT + 4h, for the date and time. You can check the time at http://tycho.usno.navy.mil/simplesimpletime.html. The Windows PC should also be set to use UT.

The date and time should be set at the DOS prompt when you start the tcs computer (see Quick Guide: Starting Up on page 4.) Changes made inside the tcs software will NOT change the computer clock, so they will not be saved if you reboot the tcs computer.

To change the date or time:

1. Select item 1 Set date and time from the initialization menu (page 12).
2. Enter the UT date and time (military/24 hour format) in the blanks provided. If the item is correct, you can hit <ENTER> to skip to the next field. Include a few seconds lead time to execute the command.
3. Answer “No” to “Any changes” when the real UT equals the time you entered.

Focusing

Miscellaneous menu item 4 is useful for moving the focus a long distance, as when switching instruments. See Eyepieces under Appendix 2: Technical Information for the 0.4-m on page 52 for approximate positions for each of the eyepieces. Note temperature and weather can affect focus positions, so this will only get you to roughly focused.

See the Focus section under Handpaddle Operations on page 18 for fine focus or more information.

To move the focuser, select Miscellaneous menu item 4, enter the position you want to move to, and answer No to “Any Changes”.
Setting the rates

Both the rate and aux rate can be changed. Generally, you should not need to change the normal rate except for long exposure tracking. The aux track rates can be used for something that doesn’t move at the sidereal rate, such as a comet. You will need to determine the rate in arc seconds per second before setting an aux rate. The rates will revert back to the default rates when the computer is rebooted.

If you have to change the rates because the telescope is not tracking normally, report it to astro-labs@umich.edu!

1. Select item 3 “Rates menu” from the main menu page
2. Select item 1 “Set track rates”
3. Adjust the rates or aux rates:
   a. Set the RA rate to 15.00 if it isn’t set to that already. If you need more precision, try 15.04, or something in between. The dec rate should be 0.000.
   b. Enter the values needed for the aux RA and dec rates. These should be close to the normal rates of 15 and 0.
4. Answer “No” to “Any changes”
5. If you are using an aux track rate, flip the TRACK/AUX TRACK switch on the front of the blue box to AUX TRACK. Please be sure to flip the switch up when you finish!
6. Go back to the movement menu, point the telescope at your object, and make sure the telescope is tracking correctly. You may need to adjust the RA rate again to get the tracking rate right.

Aligning the Dome

The encoders must be engaged to align the dome. They are not normally engaged, but if you really need them, send a request with an explanation to astro-labs@umich.edu. To align the dome and telescope:

1. Make sure the DOME TRACK” switch is set to HOME (down) and AUTODOME is off.
2. Point the telescope at a known object.
3. Center the dome opening on where the telescope is pointing.
4. Read the “TELESCOPE AZIMUTH” from the telescope position section of the tcs screen.
5. Go to the initialization menu.
6. Select item 3 “Set Dome Position”
7. Enter the same value as the telescope azimuth.
8. Answer “No” to “any changes?”
9. The “TELESCOPE AZIMUTH” and “DOME AZIMUTH” should now match. As the telescope tracks or when you move to another object you can control the dome from the control room by using the handpaddle and adjusting the dome azimuth to match the telescope azimuth. See Dome Rotation under Handpaddle Operations on page 19.
Controlling the Telescope Without TheSky

Using library objects

Movement menu item 3 “Select Library Object” lets you select an object from the tcs library. This is normally used to align the telescope (see page 6.) Note that using TheSky with TPoint will be more accurate (see page 20) but using the Library may be faster.

1. Determine which library object you want to use:
   - The library is the Sommers-Bausch Observatory Catalog of Astronomical Objects. For more information (including the object lists) visit the Sommers-Bausch Observatory website at [http://lyra.colorado.edu/sbo/manuals/sbocatalog/sbocatalog.html](http://lyra.colorado.edu/sbo/manuals/sbocatalog/sbocatalog.html).
   - An overview of the library:

```
<table>
<thead>
<tr>
<th>Catalog</th>
<th>Library number</th>
<th>Numbering system</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messier</td>
<td>001 – 109</td>
<td>Messier catalog number</td>
</tr>
<tr>
<td>Mullaney &amp; McCall</td>
<td>201 – 305</td>
<td>M&amp;M number + 200</td>
</tr>
<tr>
<td>Ephemeris Star List</td>
<td>401 – 424</td>
<td>RA to nearest hour + 400, dec</td>
</tr>
<tr>
<td>Bright Star List</td>
<td>501 – 513</td>
<td>Brightest star order + 500</td>
</tr>
<tr>
<td>Special Objects</td>
<td>514 - 528</td>
<td>513 + next SBO object</td>
</tr>
</tbody>
</table>
```

2. Select item 3 from the movement menu.
3. Enter the number of your chosen library object.
4. Answer “No” to “Any Changes?”.
5. “SLEW ENABLED” should blink at the bottom of the screen and the coordinates should appear on the “Next Object” line. If “Target out of Range” appears on the screen, the object is outside the pointing limits of the telescope. Go back to step 1 and choose a different object.
6. To cancel a valid selection, press 8 then <Enter> before slewing the telescope.
7. Select item 7 “Start Slew” and press <Enter> to slew to the object.

Manual entry of coordinates:

Movement menu item 1 “Set Slew Position” lets you enter the coordinates. You need to know the RA, dec, and epoch. Lists are frequently published for epoch 2000, while software usually gives the coordinates for the current year. The Messier catalog is in the appendix, although these objects are also in the Library (see above).

1. Select item 1 from the movement menu.
2. Enter the RA in the format hh mm ss.s
3. Enter the dec in the format dd mm ss.s
4. Enter the epoch in the format yyyy.y, or 0 for the current display epoch (it says 19xx.x, but it will take 20xx.x.)
5. Answer “No” to “Any changes?”
6. “SLEW ENABLED” should blink at the bottom of the screen and the coordinates should appear on the “Next Object” line. If “Target out of Range” appears on the screen, the object is outside the pointing limits of the telescope. Press <esc> and go back to step 1 and choose a different object.
   - Objects must be roughly 12º above the actual horizon, and 20º is preferred to avoid tracking into or slewing through the limits.
   - The pointing limits are roughly +90º to –35º in dec. Objects with a dec of around 40º have an R.A. limit of roughly the sidereal time ±5 hours. Lower declination objects will have a smaller visibility range, and objects above roughly 60º are always visible to this telescope.

7. To cancel your selection press <esc> any time before hitting <Enter>. After hitting <Enter>, use item 8 to cancel your selection.

8. Select item 7 “Start Slew” and press <Enter> to slew to the object.

**Starhopping**

Starhopping is the most common way to point a non-computer-controlled telescope, such as the C8s. It is not very convenient for the 0.4 m, but it may be useful for objects like comets, or for making minor adjustments without the handpaddle.

1. Choose a target object.
2. Find a bright object nearby. Determine the difference in RA and dec from the bright object to your target. Convert these values to arcseconds.
3. Using the handpaddle, center the bright object in the finder, then in the 35 mm eyepiece.
4. Use movement menu item 2 “Set offset” to enter the change in RA and dec to get to the target in arc seconds (999.9 maximum).
5. Use movement menu item 7 “Start slew” to slew to the new object.
6. If necessary, use the handpaddle to center the object.

**Handpaddle Operations**

There are two handpaddles, one in the dome and one in the control room. They are used for “manual” control of the telescope position, focus, and dome rotation. This is the best was to focus and to move the dome. You can also perform most of the handpaddle functions from menu items in the tcs software (page 12.)

**Focus**

1. The focus buttons are at the top of the handpaddle.
   - IN moves the secondary up away from the primary against gravity (moves the focal plane IN closer to the telescope body). This direction is preferred since gravity allows less play in the system.
   - OUT moves the secondary down closer to the primary (moves the focal plane OUT away from the telescope body)
2. The “focus” reading from the encoder on the secondary is displayed on the tcs screen. The limits are between 481 and 3752. 1 mm of secondary movement is approximately 161 units on the encoder.

3. When switching directions there is a slight hysteresis that will cause a 1 - 2 second delay before the mirror starts to move. If you are getting clearer images by tapping the focus buttons, the image clarity is being affected by something else, probably atmospheric blurring. You may get better results by switching to a lower power eyepiece.

4. High speed focus motion is obtained by holding the SET button then pressing IN or OUT. If you release the SET button the focuser will slow. To resume high speed focus you must also release the focus button.

5. See the table under Appendix 2: Technical Information for the 0.4-m on page 52 for the eyepiece list with focus positions.

6. When you switch to a shorter focal length eyepiece (higher power), move the focus in.

7. To quickly move to a new position, see Focusing under Using the TCS software on page 15.

### Moving the Telescope

1. There are four direction buttons around the set button:
   - N move north to higher dec
   - E moves east, increasing RA
   - S south to lower dec
   - W west, decreasing RA

2. There are 3 speeds:
   - SLEW is the fastest for slewing or making major adjustments while looking in the finder
   - SET is a slower speed for minor adjustments in the telescope position
   - The telescope also moves at the “guide” speed, which is used for guiding when imaging.

3. To move the telescope, hold both the speed button and the direction button. E.g. to move quickly east, hold down both SLEW and E. If only the direction button is pressed the 'scope moves at the guide speed.

### Dome Rotation

Although the TCS has the capability to rotate the dome with the telescope, the encoders are not currently enabled. Handpaddle control is the ONLY recommended way of moving the dome.

1. The dome rotation buttons are on the bottom of the handpaddle.
   - R turns the dome right (clockwise)
   - L turns the dome left (counter-clockwise)

2. If the encoders are engaged, the direction the tcs thinks the dome is facing will be displayed after “DOME AZIMUTH.” If you align the dome, (see page 16) you can control the dome from the handpaddle in the control room.
TheSky

TheSky is a computer planetarium program from Software Bisque. This manual focuses on using it to control the telescope, and capturing the observing data. It can do a lot more.

Opening

If you have never opened TheSky 6 before, go to First Time Set Up on page 23 and follow the instructions.

If you open TheSky using the desktop icon, taskbar or Start menu it will open with whatever document you had open last. See Exiting and reloading your default document on page 26 for instructions on saving and switching documents.

Make sure the document you use to control the telescope includes a TPoint model. Look for the TPoint icon in the upper left corner of the map window (see image, right.)

Linking

1. Establish a link by going to the Telescope menu and selecting “Link → Establish” or click the green telescope icon in the second row of the toolbar.

2. To disconnect, choose “Telescope → Link → Terminate” or click the red telescope icon in the second row of the toolbar.

3. “Telescope → Link → Suspend” or the yellow telescope icon hides the crosshairs and doesn’t allow slews, but otherwise you are still linked to the telescope.

Appearance

1. The white cross hair indicates the current position of the telescope (if linked), the red target indicates the current selection, and the mouse appears as an arrow pointer.

2. The default view should be everything above the horizon (90° from the zenith).
   - The z key on the toolbar will center the view on zenith.
   - To zoom, use the mouse scroll wheel or the toolbar icons that look like magnifying glasses with a + or – symbol. The HOME key on the keyboard should take you to your saved view.
   - There are a number if buttons on the toolbar to change what is displayed.
   - If you don't like the appearance of your saved document, see exiting and reloading your default document on page 26 for instructions on restoring your document.

3. If you have TheSky set up correctly and linked to the telescope, the white crosshair will remain on your screen. To stop this behavior, you can suspend the link (see above), however you can’t use TheSky to control the telescope while the link is suspended.

4. The red goggles in the toolbar will open the theme control panel rather than switching to night vision mode.

5. When you click on an object, an object information window opens. You can close it by hitting <esc>.
Controlling the Telescope With TheSky

1. Click an object to select it. The red target should appear around it and an information window should pop up.

2. If there is more than one object in the area (which is common) the top of the window will say “Object (1 of #)?”. There will be a name in the box on the same line, and an arrow indicating a drop down menu.
   a. Click the arrow to see the list of objects in the area where you clicked
   b. Select the object you want

3. FIND: to access the find command, press CTRL + f or go to Edit → Find.

4. Check the magnitude to make sure the object you selected will be visible. Generally, for extended objects, magnitude 5 is good and 6 or 7 may be worth trying. Point sources are worth trying down to around magnitude 10.

5. To send the coordinates to the tcs, click the green Newtonian-style telescope icon at the bottom of the information window (“slew”).

6. After a brief pause, progress bar will open, indicating TheSky is sending coordinates to the tcs. After a few seconds it will close, “Slew Enabled” will blink on the bottom of the tcs screen and the coordinates will appear next to “NEXT OBJECT”.

7. On the tcs, select item 7 “Start slew”, check to make sure the telescope is clear, then hit enter. DO NOT MOVE THE TELESCOPE IF SOMEONE IS LOOKING THROUGH THE EYEPIECE! It’s all fun and games until someone loses an eye…

8. Rotate the dome with the handpaddle (page 19) so the telescope is looking out the opening.

9. Use the handpaddle to center and refocus on the object if necessary (page 19.)

Exiting TheSky

Exit TheSky like you would any other Windows program. When you exit, if you have made changes, it will ask you to save.

- If you made changes you want to keep and are in normal.sky, hit <ENTER> to save.
- If you are using a write-protected document like the one with the TPoint map in the Setup folder, it will open the Save As… dialog box.
- If you have made changes you don’t like, you can recover the previous version by exiting without saving, then re-opening TheSky.
First Time Setup

Before you can use the Windows computer with the telescope for the first time (or if you haven’t used the telescope since September 2013), you will need to do some set up.

**Setting up the observatory Windows computer**

**Logging in to the computer**

Log in using your uniqname and Kerberos password. If you have any trouble, make sure it says UMICH.EDU (Kerberos Realm) under the password box. If not, click “How do I log on to another domain?” (see image, right)

The first time you log in, it will spend a minute or two setting up your local Windows environment.

**Setting up Windows**

**Display Settings / Dark Theme**

It is strongly recommended that you enable a high contrast or dark theme.

On the desktop, open the Setup folder. Double click the file named darkRed.themepack (note extensions may be hidden.) This should open the Personalization control panel and switch you to that theme. Simply close the window to keep that theme.

To access this control panel again latter, right click on the Desktop and choose Personalize.

You can make changes using the control panel and save a personal theme for yourself. The DrakRed theme is read only, so you can always go back to it.

**KnightVision**

Night vision mode in TheSky does not work, and in CCDsoft it’s very harsh. Instead, use a dark theme and KnightVision. Double click the icon on the desktop to open it.

Once it’s open, click the Dim Red button to make everything dimmer and red. This works best with a dark or high contrast theme because it doesn’t dim the other colors completely.

You can also make your screen green (enhances contrast even more, but bad for retaining night vision) and dim grey, which dims the display overall. If you adjust the sliders, click the Set RGB button to make the changes.

When you want to go back to the normal view, close the app.
**Web Browser home page**

If you have a high contrast theme enabled when you open your browser, it will probably ask you about using high contrast in your browser. In Chrome, that means installing the high contrast extension (recommended, and pay attention to the instructions). In IE, it will mean paying attention to the quickly disappearing instructions on how to disable and re-enable it. The browser may also ask about installing a dark theme, which you are welcome to do, but it does take time to browse the themes.

A webpage made especially to act as the home page for this computer is at

https://dept.astro.lsa.umich.edu/homepages/AHOhome.php

There is a text document in the Setup folder if you'd like to copy and paste the link into a browser.

There are many useful links, including links to the USNO timeserver and the trouble reporting website. You may want to open the timeserver page in a new tab before setting the homepages. You may also want to close things like start pages or search pages. Once you have the pages set the way you want them:

**Chrome:** Click the “Customize and control Google Chrome” symbol in the upper right corner and choose Settings from the drop-down menu. Under the section labeled “On startup” select “Open a specific page or set of pages.” Click “Set pages” and then click the Use current pages button in the box that opens.

Alternatively, select “Continue where I left off” under “On startup” and then, under the section labeled Appearance, check the box next to “Show Home button”, click Change and paste the url of the homepage into the text area.

**Internet Explorer:** Click the arrow to the right of the Home button Picture of the Home button, select Add or Change Home Page, and then click the option to use the open tabs.

**Setting up the box client**

This is the best (UM sanctioned) cloud storage option, since it looks just like another drive to software like CCDSoft, can be accessed from any internet enabled device, and doesn’t give pop up notifications about how much better life would be if you used it’s proprietary file type instead. The ssh client is also installed on the computer if you prefer to use it (and have a machine you can connect to), or you can install the Google Drive desktop client.

Before setting up the box client, you must have a UMICH box account. Go to http://www.itcs.umich.edu/storage/box/ and click "Sign up for an M+Box account" to get your umich box account. Once you have an account:

1. Click on the box icon (see image, right) in the system tray OR go to the start menu, and type Box Sync in the search field.
2. In the window that opens, check "Use my company’s single sign-on credentials." This should open a browser window with the CoSign login. Follow the on-screen prompts to finish the set up.
3. A shortcut to your Box folder should appear on the desktop. Programs like CCDsoft and TheSky should be able to access this folder like any other on the computer:
Setting Up TheSky

1. In the Setup folder on the desktop, double click skySetup.sky.
2. When it opens, TheSky will show you the tip of the day. It’s up to you if you want to continue to get this tip or not. If not, uncheck the checkbox. Close the tip window.
3. Go to File → Save As, click Libraries on the left, then double click Documents to go to your Documents folder. Give the file a name you’ll remember (Normal.sky is the default, so it will match the documentation) and click Save.
4. In future, use the icon labeled TheSky (see image left) and it will open the last .sky document you had open. See Exiting and reloading your default document on page 26 for more about switching documents.
5. For ease of access you may want to right click on the icon in the task bar and tell it to “Pin this program to Taskbar”. You may also want to do that with your web browser, CCDSoft, or anything you’re likely to use often.

Setting up the telescope

1. Make sure the location is correct by going to Data → Location. Ann Arbor is listed under United States and is sufficient, but the most accurate pointing will be achieved using the Angell Hall Observatory. If there isn’t a User Defined Locations list and you have the time, click the User Defined tab and enter the coordinates (see appendix 2, page 51.) Be sure to save it.
2. Make sure “Use Computer’s clock” is enabled by going to Data → Time or making sure the clock icon in the toolbar looks pressed in, with a grey background: ☐ not ☐.
3. Click the Telescope Setup icon in the toolbar or go to the Telescope menu and choose Setup (the very first item).
4. In the drop down list, choose ACL compatible Telescope (the second item.)
5. Click the Settings… button and make sure the port is set to COM 1, the Baud rate to 9600, and the “Use MNCP Proxy” checkbox is unchecked.
6. Click OK to go back to the Telescope Setup window.
7. The image here shows the usual set, which is NOT the default set. **The last two checkboxes must be checked.** A few are not recommended or require some other setup. Although it is possible to make changes while linked to the 'scope, doing so can result in unexpected behavior or crash the tcs.

- Confirm Slews will ask if you really want to move the telescope. Very annoying and pointless.
- Confirm syncs will ask if you really want to sync. Annoying.
- Confirm mapping is used with TPoint to confirm new coordinate points **Use this ONLY if you are generating a new pointing model.**
- Impose Slew Limits uses the slew limits set in TheSky. The tcs slew limits are sufficient, and this requires additional setup, so this is **NOT recommended**
- Attempt to stop slews in progress through slew limits won’t work because the tcs controls the telescope’s movement. **NOT recommended.**
- Switch to Night Vision Mode opens the Theme control panel so you can change to the night vision theme. **NOT recommended.**
- Show the number of packets, retries and failures gives information about how TheSky is communicating with the tcs. This is useful if you are having problems communicating with the tcs, testing integrated software like TPoint or CCDSoft, or if the tcs, TheSky or CCDSoft keep crashing (rare.)
- Close Object Information dialog box upon slew closes the information box once you tell the telescope to slew. It generally makes the screen cleaner.
- **Enable telescope modeling** enables the TPoint modeling software, which is currently needed for accurate pointing. **This must be checked.**
- **Always keep telescope cross hairs on screen** will keep the cross hairs on the screen when you are linked to the telescope so you can always see where the telescope is pointed. **This must be checked.**
- Cross hair update frequency tells the computer how often to update the position of the telescope cross hairs. 500 is a good setting. Too often can slow down the computer, too seldom and you won’t really be able to tell where the telescope is pointing.

When the boxes are checked as you want, click Close, then save.
Changing what is displayed

There are several buttons in the second row of the toolbar to turn things like stick figures, binary stars, or galaxies off and on. However it is often more useful to adjust how many of each type are displayed.

Go to View → Display Explorer.

- To change what objects are displayed, click the + to expand the category and subcategory, then click the icon next to Display properties.
- In the object properties box, you can adjust the Magnitude Limits. You can also change the appearance of the labels and symbols.

Once you have the objects that you want displayed, you may want to change the labels. Go to View → Labels → Setup…

- Check the checkbox next to the objects you want labeled (the check may not be visible in with a high contrast theme.) All will check all (making a very densely labeled display), None will remove all labels.
- Click Apply to see what the changes will look like, or close to implement the changes and close the window. Don't forget to save if you like your changes.

Exiting and reloading your default document

1. To exit or quit TheSky, go to File → Exit. If you have made changes, you will be prompted to save:
   - To save your changes, click Yes. If you don’t have write permissions for the document, the Save As… dialog box will open, and you’ll have to rename the document, or save it to a different locations (saving to your Documents folder is recommended.)
   - If you don’t like your changes, click No. The program will exit.
2. The default document is usually Normal.sky in your My Documents folder. Navigate to it in Windows Explorer, and double-click to open, or go to File → Open if TheSky is already open. You can also go back to the Setup folder on the desktop and start over.
3. If you saved changes to your Normal.sky that you don’t like, find the document with the pointing model on the desktop, open it, go to File → Save As, and save it as Normal.sky in your My Documents folder. If it asks if you want to replace your existing Normal.sky, tell it yes. Make any changes (like changing the number of stars visible) and Save.
4. To open a different document, go to File → Open, or choose one of the recent files in the File menu. If you made changes to the current document, it will prompt you to save before opening or switching to the new document.
5. If you double click any .sky document in Window Explorer, it will ask you if you want to open a second instance of TheSky. Having two instances open could be confusing, especially if you link to the telescope.
Setting up CCDSoft

If you won’t be using the CCD camera, you are done with first time set-up.

Before setting up either camera for the first time, make sure both cameras are off. (See page 11.)

The imagers talk to the computer on two different ports, so it’s possible to connect to both at the same time. To do this, you need to use the program CCDOps to connect to one of the CCDs. However, you can’t have light going to both and therefore can’t actually use both at the same time, there are no instructions here for CCDOps.

When you open CCDSoft, it may give a warning about updating the Registry and jump to the background. The error will close on its own, and return CCDSoft to the foreground if you wait a moment.

Set the preferences

1. Go to File → Preferences.
2. The Startup options checkboxes can be set the way you want. Astronomy software integration should be set to TheSky 6 Professional Edition.
3. Click Apply, and then click OK.

Capturing observing data

CCDSoft should get the basic information (like RA and dec) from TheSky. You can tell if it is working because the file name will contain the object’s coordinates or name. If it fails, try logging out and back in again, and make sure you have TheSky linked to the telescope before starting CCDSoft.

To see what information CCDSoft includes in the metadata, select an image and press <ctrl>+I to open the FITS Information window (there is a test image in the Setup folder on the desktop.)

To change what data are recorded, click the Edit Header tab.

- Select the Keyword you want to edit (OBJECT in the image to the left.) In the Value box in the “Edit value” area enter the new value. Click Set to change the value, and Apply to save it.
- To delete the information, select the Keyword then click the Delete Keyword button. Click Apply to save the changes.
- To add more information, select a keyword from the dropdown under “Add keyword” and click the Add button. The keyword should appear in the Edit value area. Type the Value into the text box and click Set. Finally, click Apply to save the changes.

If your changes are not object specific (e.g. if you add a value or change the observer name) CCDSoft will remember that change for subsequent images.
Setting up the CCDs and Spectrograph

Setting up CCDSoft for imaging

If this is the first time you have used CCDSoft, make sure to set the preferences first (above). Also don’t forget you’ll need to check the metadata after your first image. If you need to use the spectrograph, see the next section.

1. Go to Camera → Setup or press Ctrl+W to open Camera Control window.
2. Make sure the Setup tab is active. The image below shows what this should look like if you are set up for imaging.

3. Make sure Imager is selected (not Autoguider).
4. If the Camera field is blank, click the arrow for the dropdown menu and select the SBIG ST-8.
5. Click the Settings button next to the Camera drop down to bring up the Settings dialog box.
   a. Next to the Interface box, click the … button to get a drop down menu. Select USB. Click OK to close the Interface Settings dialog box.
   b. The check boxes should not be checked, and Vertical N binning should be 1.
   c. Click OK to close the camera settings dialog box. This should put you back at the Camera Control dialog box.
7. Click the settings button next to the filter wheel.
   a. Type the correct filter names into the spaces. Hit <Tab> to navigate to the next field.
   b. When the listed filters are correct, click OK.
8. Back in the Setup tab again, check “High Priority Downloads.” The rest of the checkboxes depend mostly on your preferences and what you’ll be doing.
9. Go to the AutoSave tab.

10. Click the Imager radio button (see image above).
   
   a. Check the AutoSave On checkbox.
   
   b. Under the AutoSave folder area, click the “Choose Folder…” button. If you set up Box Sync, you can create a folder for this observing session in your default sync folder (see page 23.) Otherwise, create a folder in your Library/Documents folder.
   
   c. Under the “Save as” section, make sure FITS is selected.
   
   d. If you want, you can add a prefix to the files in the “File name prefix” box (e.g. if you are doing this for a class you may want the file to start with your uniqname.)
   
   e. If you have pre-existing images, you can change the starting number.
   
11. If you will also be using the autoguider and want to keep the images, click the Autoguider radio button, and repeat the above steps.

See page 30 for turning the camera on, and page 32 for instructions on capturing the images.
Turning the USB (Imaging) Camera On and Connecting

1. Before proceeding, make sure:
   a. The telescope is set up with TheSky linked to it,
   b. You are centered on an object with the eyepiece, and
   c. CCDSoft is set up for imaging. You may want to check the AutoSave settings for both the imager and autoguider before proceeding.

2. Turn on the power to the USB CCD (see page 11.) Note when the computer detects a new USB device, it will let you know. If you are having any connection problems, check for a message from the system tray:

3. If the “Camera Control” window isn’t open, open it by going to Camera → setup, or type “Ctrl+W”. If necessary, switch to the Setup tab.

4. Click “Connect” to connect to the camera. If you get a “SBIG driver: Camera not found” You will need to go through the Troubleshooting: CCD connection problems section on page 47.

5. Click the “Temperature” button to get the temperature control window. Select the temperature setpoint (0° C is the default, -10° C is recommended) and click “On” to start the camera cooling.

6. Rotate the Sidewinder mirror to send light to the imaging CCD (see page 9). Adjust the focus to around 1570.

7. Skip down to “Capturing the Image” page 33 for instructions on taking the image.
Setting up CCDSoft for Spectroscopy

If this is the first time you have used CCDSoft, make sure to set the preferences first (page 27.) Also don’t forget you’ll need to check the metadata after your first image. If you need do imaging, see the previous section.

1. Go to Camera → Setup or press Ctrl+W
2. Make sure the Setup tab is active. This image shows the standard spectroscopy set-up.

3. Make sure Imager is selected, not Autoguider.
4. If the Camera field is blank, click the arrow for the dropdown menu and select the SBIG ST-8/8E/8XE.
5. Click the settings button next to the Camera drop down to bring up the Settings dialog box.
   a. Next to the Interface box, click the … button to get a drop down menu. Select LPT1. Click OK to close the interface dialog box.
   b. Check “Use off-chip binning” and set the Vertical N binning to 4. Leave the last checkbox empty. Click OK to get back to the Setup tab.
6. If the Filter Wheel field is NOT blank, click the arrow to get the drop down menu and select “<None Selected>”
7. Make sure “High priority downloads” is checked. The other boxes are based on your preferences.
8. Go to the AutoSave tab.
9. Click the Imager radio button (see image right).
   a. Check the AutoSave On checkbox.
   b. Click the “Choose Folder…” button. If you set up Box Sync, you can create a folder for this observing session in your default sync folder (see page 23.) Otherwise, create a folder in your My Documents folder.
   c. Under the “Save as” section, make sure FITS is selected.
   d. If you want, you can add a prefix to the files in the “File name prefix” box (e.g. “SGS_” for spectrograph images.) If you have pre-existing images, you can change the starting number.
10. Click the Autoguider radio button and repeat the above steps.
Turning on the Parallel Camera and SGS Spectrograph and Connecting

1. Before proceeding, make sure:
   a. The telescope is set up with TheSky is linked to it,
   b. You are centered on an object with the eyepiece, and
   c. CCDSoft is set up for spectroscopy. You may want to check the AutoSave settings for both the imager and autoguider before proceeding.

2. Turn on the power strip on the side of the pier to give the camera power.

3. Go to the Setup tab and click Connect to connect to the camera. If you can’t connect, see the troubleshooting section on page 47.

4. Click Temperature to open the Temperature window. Click “On” and adjust the setpoint (the recommended is actually -10°C) and click OK.

5. In the Take Image tab, make sure the imager radio button is selected and set the bin factor to 1x4.

6. Pull the mirror out so light can go to the spectrograph (page 10.) Adjust to focus to around 1440.

CCDSoft is now ready to capture the spectra. See page 35 for manual adjustments (like changing gratings), or the next section for taking the image.
Capturing the Image

Click the “Take Image” tab. There are a lot of options here you’ll need to choose from. A description of the options is below.

a. Exposure:
   i. Minutes and Seconds control the length of the exposure.
   ii. Delay sets how long to pause between shots in a series or after you click “Take Image.”
   iii. Series allows you to take several images in a row. The normal setting is a Series of: 1 and Delay (s): 0, which takes an individual image.

b. If you are set up for imaging with the USB CCD, click the arrow in the Filter box and select one of the filters: B, V, R, I, or H-alpha. Filters are not available for the spectrograph.

c. A Subframe is a small section of the full image, which can be downloaded separately (and more quickly) than the full image. This is useful for focusing and guiding while imaging, or if you are trying to capture a small portion of the spectrum. Use the Size button to define the subframe.

d. Bin controls how the pixels in the CCD are read out.
   • 1x1 is the standard for imaging, and gives the highest resolution. It is the normal setting for the autoguider.
   • 3x3 is low resolution, but the readout is much faster. The table below summarizes the NxN options.

<table>
<thead>
<tr>
<th>Binning factor N</th>
<th>Pixel Size (&quot;)</th>
<th>Parallel camera Readout time (sec)</th>
<th>USB camera readout time (sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.57</td>
<td>58</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>1.14</td>
<td>19</td>
<td>1.5</td>
</tr>
<tr>
<td>3</td>
<td>1.71</td>
<td>11</td>
<td>&lt;1</td>
</tr>
</tbody>
</table>

   • If you are using the spectrograph, you should set it to one of the 1xN binning options. 1x4 (as shown in the image to the right) is the highest resolution.
   • Nx1 will result in a vertically elongated image.

e. Frame is what type of image to take. Light is the regular image, and you can choose a Reduction to apply. To take a flat field you will need to set up a screen, and there is currently no mount.

f. Reduction is what type of reduction to apply. The software can automatically apply a dark frame, flat field, bias, or all. Dark is recommended, since there is always a lot of noise in the camera.

g. “To new window” causes the image appear in a new window. If this is unchecked, CCDSof will close the last image taken as soon as the next image finishes downloading. It will not close windows opened by going to File → open. Having the box checked makes it easier to compare images. Leaving it unchecked will give you a cleaner workspace.

The Imager and Autoguider radio buttons select which chip to use. The autoguider is much faster than the main chip, and can be useful for focusing and (of course) guiding. When using the spectrograph, use the autoguider to focus and center the slit on the object (see Aligning the Spectrograph on page 36.)
1. Select all the settings you want for your image.

2. Check that light is going to the correct instrument. Turn out all the lights in the dome.

3. Click “Take Image”. If a filter was selected, it will rotate to the correct filter. It will take the exposure then download it. If necessary, it will automatically take a dark frame. The original image and the dark-subtrajted image should open in the CCDSoft window.

4. To focus using the imager (do not do with the spectrograph)
   a. Click the autosave tab and turn off autosave.
   b. Set an appropriate exposure time and take a single exposure
   c. Draw a box around a star in the field from the first image
   d. Click the focus tab, make sure the subframe and binning are correct and click “take image”
   e. Adjust the focus (you’ll probably need to use the handpaddle) until your image looks good and the sharpness graph is at its maximum. Note the heat shimmer and building shake make it almost impossible to get a really good focus.
   f. Turn autosave back on before going back to the “take image” tab.

5. To focus using the autoguider:
   a. Click the autosave tab and turn off autosave for the autoguider.
   b. Take an image with the autoguider (make sure the Autoguider radio button is selected on the Setup tab)
   c. Click the focus tab, make sure the subframe and binning are correct and click “take image.”
   d. Adjust the focus (you’ll probably need to use the handpaddle) until your image looks good and the sharpness graph is at its maximum.
   e. Turn autosave back on before going back to the “take image” tab.

6. If taking a spectrum, you should get a long narrow image with spectral lines along the top. It not:
   a. Check your exposure time – too short and the lines won’t be recorded, too long and they can be washed out by the background
   b. Make sure you take a dark frame – the noise in the camera can wipe out faint lines.
   c. Check your alignment (see page 36.)

7. If taking a spectrum, you may wish to adjust the micrometer and take another image to ensure you capture the full spectrum. If so, be sure to note the micrometer position for each image.

**Shutting Down the camera**

1. Click the “Temperature” button and turn off cooling.

2. Click the “Disconnect” button to disconnect from the camera.

3. Turn off the power inverter and/or the power strip to turn off the camera(s) (see page 11.)

4. Turn the Sidewinder so the light goes out the eyepiece (see page 10.)

5. Exit CCDSoft.
The SGS Spectrograph

SGS manual adjustments

Grating selection

The spectrometer has a low resolution and high-resolution grating. The lever on top, next to where it connects to the telescope, switches between the two. When the lever points toward the handles, the high-resolution grating is in place (see image).

Autoguider Shutter

The lever on top of the spectrograph adjusts whether light goes to the tracking CCD. With light passing to autoguider, the imaging ccd may saturate in the area below the autoguider, so you generally want the autoguider blocked when collecting data.

• parallel to the line from the telescope to the camera allows light through,
• parallel to the long side of the spectrograph (see image) blocks the light from going to the autoguider.

Slit Illumination

A small LED inside illuminates the slit on the autoguider to make sure you have the slit aligned with your object. The switch on the side with the handles turns the light on and off. The dial next to the switch (that looks rather like another switch) adjusts the brightness. The LED next to the switch tells you if the lamp is on.

How to read the micrometer:

The micrometer shows the position of the mirror.

On the inner shaft are two sets of small lines on either side of the dividing line. The side with the numbers on it marks off whole millimeters. The other side has half mm marks.

The dial runs from 0 – 49. It travels half a mm in one complete rotation.

In the image, the micrometer reads 7.02

To set the micrometer to 5.64, turn the dial to the first mark on the bottom after the 5, then rotate until the 14 mark on the dial aligns with the center line: 5.5+.14=5.64.
Aligning the spectrograph and focusing on an object.

1. Make sure you go through the steps to set up and turn on the parallel CCD and SGS on page 32 before trying to align on an object.

2. In the Take Image tab, make sure you are set to use 1x1 binning and the Autoguider, and adjust the rest of your setting to something appropriate for your object. (see page 32.) The image at right shows a typical set-up for a moderately bright star (m ~3.)

3. Flip the shutter on the SGS so light can go through to the autoguider (see page 35.)

4. Click the “Take Image” button to capture the image.

5. Once the image has downloaded, you should be able to identify your object in it. Use the handpaddle to adjust the focus and position. If you need the object in a special orientation (e.g. if using a trail or trying to capture the spectrum from one side of an object), use the rotator (see page 9) to adjust the orientation. WATCH THE CABLES!

6. Take another image, and adjust the focus, position and rotation again.

7. When you have the object centered nicely, move to the tcs computer, go to the initialization menu, set telescope position, and enter 0 for everything. This should improve the pointing for you next target. Hit escape and go back to the movement menu. Finish focusing if you need to.

8. Move the telescope to your real target.

9. Illuminate the slit and take another image with the autoguider to make sure the slit is on your object where you want it. If not, use the handpaddle to adjust it. Note if you are imaging a very bright object (e.g. a solar spectrum reflected by clouds or the Moon) the LED may not be bright enough to make the slit brighter than the background. However, since objects that bright are generally very large, you probably don’t need to worry about careful alignment. Remember, NEVER POINT AT THE SUN.

10. Once the target and slit are aligned, you are ready to capture its spectrum.
Troubleshooting

If you have any trouble that you cannot completely resolve, email astro-labs and leave a note on the white board so others aren’t surprised if they encounter the same problem. If it is an urgent issue such as being unable to get the telescope upright or unable to close the dome, please use the phone list on the cork board in the control room, and do not leave until you have gotten hold of someone.

Issues With the Dome

Dome won’t rotate

- Is there any sound when you push the buttons on the handpaddle?
  - Yes, a click
    - Yes
    - The gears are slipping. Are there any obstructions (e.g. a ladder, or the power cord for the shutter control)?
      - No
      - Yes
        - Remove them and check for damage. Report the incident
        - No
          - Yes
            - The TCS has power and is on, but the motors don’t have power. Is the dome rotation power cord plugged in?
              - No
                - Plug it in!
              - Yes
                - Yes
                  - Report the outage to astro-labs. Observe where the dome is pointed. Wait for power to be restored or use the emergency contacts, cover the optics and close dome manually (see Dome won’t close on page 39)
                  - No
                    - Make sure the power cord is plugged in securely. If it is: Report the problem. Use the 240 V extension cord located in the cabinet in the control room to try another outlet. If that still doesn’t work: Observe where the dome is pointed. See “Dome won’t close” on page 39 when you’re ready to close the dome.
    - No
      - Yes
        - Is there any sound when you push the buttons on the handpaddle?
          - Yes, clanking, clunking, thumping...
          - Yes
            - Is the 480 V power on? (try closing the dome or the vent fan)
              - No
                - Report the problem. Close the dome (See “Dome won’t close” on page 39.) Use the phone list if you can’t get it closed.
              - Yes
                - Does the tcs status area say “DRIVES ON”? 
                  - Yes
                    - Restart the TCS computer (see pg 8)
                    - Doesn’t Work
                      - Report the problem. Close the dome (See “Dome won’t close” on page 39.) Use the phone list if you can’t get it closed.
                    - No
                      - Does the tcs status area say “DRIVES ON”? 
                        - Yes
                          - Restart the TCS computer (see pg 8)
                          - Doesn’t Work
                            - Report the problem. Close the dome (See “Dome won’t close” on page 39.) Use the phone list if you can’t get it closed.
                        - No
                          - Is the drives switch on the blue box up?
                            - Yes
                              - Restart the TCS computer (see pg 8)
                              - Doesn’t Work
                                - Report the problem. Close the dome (See “Dome won’t close” on page 39.) Use the phone list if you can’t get it closed.
                                - No
                                  - Flip it up
                                    - Doesn’t Work
                                      - Try to operate from downstairs (see Aligning the Dome on page 16)
                                      - If you are with a class, skip to the next box.
Dome won’t open

- **Is the shutter control power cord plugged in?**
  - Yes
  - **Is there power in the dome?**
    - Yes
    - **Are there any obstructions?**
      - Yes
        - Clear them or don’t open the dome. Report the problem and leave a note on the white board.
      - No
        - **Does the upper shutter move or is it open?**
          - Yes
            - **Is the upper shutter open at least 1 m?**
              - Yes
                - Close the dome, report the problem and leave a note on the white board.
              - No
                - **Is the drop out shutter hydraulics switch on (left) or off (center)?**
                  - Off
                    - Turn on the hydraulics
                  - On
                    - **Are you pulling down on the handle with the black knob?**
                      - Yes
                        - Close the dome, report the problem and leave a note on the white board.
                      - No
                        - **Is there any noise?**
                          - No
                            - Pull down on the handle
                          - Yes
                            - If the lower shutter is closed, the upper shutter is open, and you’re pulling down on the handle, there’s something wrong with the hydraulics. Close the dome, report the problem, and leave a note on the white board.

- No
  - **Plug it in!**

- **Is there power in the dome?**
  - No
    - **Do not open the dome. Report the problem using the emergency contacts list. Leave a note on the white board.**
  - Yes
    - **Is the switch pushed to the left?**
      - Yes
        - **Do not open the dome. Report the problem and leave a note on the white board.**
      - No
        - **Push it to the left**

- **Are there any obstructions?**
  - No
    - **Is the switch pushed to the left?**
      - No
        - **Wait for it to open 1 m before trying the lower shutter or (if it won’t open that far) close the dome, report the problem and leave a note on the white board.**
Dome won’t close

Is the shutter control power cord plugged in?

Yes

No

Does the power cord reach an outlet?

Yes

Plug it in (preferably in its home position)

No

Does the dome rotate?

Yes

Rotate the dome to the home position and plug in the cord

No

Use the 240 V extension cord located in cabinet 1 in the control room. Outlets are on the N, E and S sides of the dome. Use the ladder to reach the shelf if necessary.

Is the power out? Is there another reason you can’t close the dome?

Yes

Close the dome manually:
- Use the emergency contacts to let someone know you can’t close the dome.
- Cover the optics. Get the crank stored under the west side of the dome, hook it into the loop at the top of the upper shutter and crank until the upper shutter is closed (this will take several minutes!) The lower shutter cannot be closed without power.
- Get the tarps from the cabinet in the control room to cover the telescope, computers and electronics. Move lightweight items (lamps, keyboards…) downstairs or into the lift.

No

Are there any obstructions?

Yes

Clear them away and check for damage. Report the problem.

No

Does the upper shutter move/is it closed?

Yes

Is the upper shutter open at least 1 m?

No

Open 1 m before closing the drop out shutter

Yes

Is the switch pushed to the right?

No

Push it to the right

Yes

Try to close the drop out shutter, then crank the upper shutter closed (see above)

Is the drop out shutter hydraulics switch on (left) or off (center)?

Off

Turn the hydraulics on

On

Is the handle being pushed up?

No

Push up on the handle

Yes

Is there a noise?

No

The hydraulics should hum, no hum means something is wrong. Close the upper shutter and use the emergency contacts list to contact someone.

Yes

A squeal: if the lower shutter is open and you are pushing up on the handle, something is wrong with the hydraulics. Use the emergency contact list to get hold of somebody.
Telescope Pointing Problems

The target is not in the eyepiece (or telescope was bumped)

- Can you see anything through the eyepiece? No → See "...nothing visible in the telescope" on page 41
- Yes → Are you still setting up, or did this start later? If yes → Set-up
- Later → Is the 'scope tracking? No → See "...tracking" on page 43
- Yes → Restart the system (pg 8). Report the problem
- Doesn't work → Shut down and report the problem. Use the emergency contacts if you can't move the telescope to zenith.

- Is the target in the finder? Yes → Can you move the telescope normally (try the handpaddle)? Yes → Is the target centered in the finder? Yes → Follow steps 10 - 17 under Aligning the Telescope on page 6. If it doesn't work, restart (pg 8), and report the problem.
- No → Is the 35mm eyepiece in? Yes → Switch eyepieces, refocus, and center before going to higher magnification. Seeing may be too bad for higher mag.
- No → See Can't Focus the Image on page 49

- Is it bright enough to see in the finder? Yes → Does the telescope move at all? Yes → Are the objects in focus? Yes or can't tell → Try a bright, non-diffuse object: Moon, planet, or bright star. If all else fails, restart (pg 8).
- No → See Telescope Doesn't Move on page 44

- Is the 'scope tracking? No → See "...tracking" on page 43
- Yes → Restart the system (pg 8). Report the problem
- Doesn't work → Shut down and report the problem. Use the emergency contacts if you can't move the telescope to zenith.
There is nothing visible in the telescope

Is this the first object for the evening, OR is the view through the eyepiece dark grey or totally black?
- First/black
  - Was the telescope cover removed?
    - Yes
    - Is the telescope pointing out the opening in the dome?
      - No
      - Rotate the dome until the telescope is pointed out the opening.
    - Yes
      - Make sure the Sidewinder is sending light to the eyepiece (page 10.)
      - It is
      - Is anything visible in the finder?
        - No
        - Is the telescope pointing out the opening in the dome?
          - No
          - Rotate the dome until the telescope is pointed out the opening.
          - Yes
          - Is that area of the sky clear?
            - No
            - Observe in a different area or shut down for the night
            - Yes
            - Move to a brighter object and 35 mm eyepiece to check the telescope alignment and focus (pg 18). To re-align follow steps 6 - 10 on page 6. If all this fails, shut down and report the problem.
        - Yes
          - Move the focus to the position in the table (see Focusing on page 15.)
        - Doesn’t work
          - Move to a brighter object and 35 mm eyepiece to check the telescope alignment and focus (pg 18). To re-align follow steps 6 - 10 on page 6. If all this fails, shut down and report the problem.
  - No
    - Remove it.

Not first/grey

Is anything visible in the finder?
- No
  - Is the telescope pointing out the opening in the dome?
    - No
    - Rotate the dome until the telescope is pointed out the opening.
    - Yes
    - Is the focus reasonably close to the position in the eyepieces table on page 52?
      - Yes
      - Move to a brighter object and 35 mm eyepiece to check the telescope alignment and focus (pg 18). To re-align follow steps 6 - 10 on page 6. If all this fails, shut down and report the problem.
      - No
      - Move the focus to the position in the table (see Focusing on page 15.)
    - Doesn’t work
      - Move to a brighter object and 35 mm eyepiece to check the telescope alignment and focus (pg 18). To re-align follow steps 6 - 10 on page 6. If all this fails, shut down and report the problem.
  - Yes
    - Move to a brighter object and 35 mm eyepiece to check the telescope alignment and focus (pg 18). To re-align follow steps 6 - 10 on page 6. If all this fails, shut down and report the problem.

Is the focus reasonably close to the position in the eyepieces table on page 52?
- Yes
  - Move to a brighter object and 35 mm eyepiece to check the telescope alignment and focus (pg 18). To re-align follow steps 6 - 10 on page 6. If all this fails, shut down and report the problem.
- No
  - Move the focus to the position in the table (see Focusing on page 15.)

Move the focus to the position in the table (see Focusing on page 15.)
The crosshair on TheSky does not match where the telescope is pointing

Did it start when the link was established or the first move, or some time latter?  

Did you zoom in, zoom out, or move the virtual sky?  

Yes

Hit F5 or View → Redraw screen. Check it’s still using computer time (Tools → Computer Time OR Data → Site Information → Time tab, check "Use Computer’s Clock) Terminate and re-establish the link. Exit and restart TheSky

No

Latter

Did you zoom in, zoom out, or move the virtual sky?

Yes

No

Hit HOME to un-zoom, z to center the zenith or right-click and select “Look → zenith” Use the manual for TheSky available on the desktop for more troubleshooting, or operate without TheSky (see page 17.).

Didn’t work

Did the link establish when the first move, or some time latter?

established/
first move

Did you set the date and time on startup and are they still correct?  Note the tcs uses military/24 hr time format. Double check AM/PM and the date (UT!) with the USNO master clock linked on the windows PC.

Yes

No

Report the problem. Terminate the link with TheSky, shut down the PC, count to 10, and reboot. If the time does not automatically correct itself, operate without TheSky.


Yes

See Setting the Date and Time on page 15.

Is TheSky using the correct date and time? (check the clock icon on the toolbar – see page 24 for images.)

Yes

No

Go to Data → Time OR click the clock button in the toolbar.

Is the date and time on the PC correct? (Remember it’s on local time, UT -4 EDT or -5 EST.)

Yes

No

Report the problem and operate from the tcs.
Problems With Telescope Motions

Telescope isn’t tracking

- Is “Approaching Limits” or “Limits Reached” flashing on the TCS? Yes → See Telescope limits on page 46
  No → Under the Status section on the TCS, do both TRACK and DRIVES say ON?
    No → Check the TRACK and DRIVES switches on the control box and make sure they are on (up). If the switches are up but TRACK and DRIVES remain off, restart the telescope (see page 8.) If that fails, shutdown and report the problem.
    Yes → Is the TRACK rate 15 or 15.04? No → Restart the telescope (see page 8). If the problem persists, shut down and report the problem.
      Yes → Is the TRACK rate 0? No → On the blue box, is the first switch on TRACK or AUX TRACK?
        No → Are you observing something that doesn’t move at the sidereal rate?
          No → Set it to TRACK
          Yes → Have you used the “Set zenith position” command? Yes → See Setting the Rates on page 16.
            No → Report the problem and shut down. Use the emergency contacts if you can’t get the telescope back to zenith.
        Yes → Is the tcs responding? No → Restart the system (see page 8). If that doesn’t work, shut down and report the problem.
          Yes → Are the motors running? (audible hum, scope moves) No → Is the green light on the box in the control room on?
            No → See Telescope limits on page 46
              Yes → Report the problem and shut down. Use the emergency contacts if you can’t get the telescope upright.
            Yes → Can you move to a new object? Yes → Restart the telescope (see page 8). If the problem persists, shut down and report the problem.
              No → Does the ‘scope respond to the handpaddle? Yes → See Telescope limits on page 46
                No → Report the problem. Try restarting the telescope (see page 8). If restating doesn’t work, you’ll have to shut down. Use the emergency contacts if you can’t get the telescope upright.
Telescope doesn’t slew to new coordinates

Are there coordinates listed under “Next object:”

Yes

Does it say “target out of range”

No

Choose an object closer to zenith

Yes

No

Does it say “Approaching Limits”

Yes

No

See Telescope limits on page 46

See the object window still open?

Yes

No

Is the object window still open?

Yes

No

Is the link still active (see Appearance under Using TheSky on page 20)

Yes

No

Re-establish the link (see page 20)

Send the coordinates again. Watch to see they are sent (look for the progress bar to open AND close) and for error messages in both TheSky and the tcs. Terminate and re-establish the link (page 20). Exit and re-start TheSky. Report the problem, and use the tcs (see page 17.)

Did you send the coordinates from TheSky?

Yes

No

Did you enter coordinates using item 1 from the movement menu?

Yes

Re-enter the coordinates. Compare them to the current position and make sure the 'scope won’t pass through the limits when slewing. Restart the system (see page 8.)

No

Did you enter a valid library object?

Yes

Re-enter the object. Compare the coordinates to the current position and make sure the 'scope won’t pass through the limits when slewing. Restart the system (see page 8.)

No

Did you enter an offset or use a table entry?

Yes

Check your units (must use arcseconds for offset) or coordinates. Compare the final position to the current position and make sure they make sense, and that they won’t take the 'scope through the limits.

No

Did you use item 6, “Start Trail”?

Yes

See page 13 for instructions on setting up a trail under the rates menu. If it still doesn’t work, report the problem. Finish without the trail, or shut down for the night.

No

Did you use “Set Zenith Position”?

Yes

Use the levels and the handpaddle to get the telescope to zenith and restart.

See also, Telescope doesn’t move or telescope doesn’t respond to handpaddle, below.

No

There are no other ways to enter coordinates. If it doesn’t move at all or isn’t responding to the handpaddle, see below.
Telescope Doesn’t Move

NOTE: if the telescope won’t slew but does move for the handpaddle, see the section above. If it won’t move for the handpaddle but will move when you enter coordinates, see the section below.

Telescope doesn’t respond to Handpaddle

Are both handpaddles affected (try the one in the control room)?

Yes

Is the tcs responsive?

Yes

Restart the system (see page 8). If the problem persists, report the problem and use the other handpaddle if possible, or use only the tcs (see page 12.)

No

Restart the tcs (see page 8)

No

Restart the system (see page 8). If the problem persists, report the problem and use the tcs to enter all the commands (see page 12.).
Telescope limits

Software limits
The telescope will not normally allow you to enter coordinates that will cause the telescope to end in the software
limits. However the software may allow the telescope to pass through the limits as it slews to the target, and it will
allow it to track into the limits.
As you approach the software limits, “APPROACHING LIMITS” flashes on the tcs screen and the ’scope moves
at half speed.
If the telescope is slewing
1. Release the handpaddle buttons or use movement menu item 8 “Stop” to stop the telescope from slewing.
Once you hit the limits, “LIMIT REACHED” will flash below “APPROACHING LIMITS”, the telescope will not
slew any farther in that direction. It may continue to track however, so it important not to leave it at the limits west
of the meridian.
To get out of the software limits:
1. Look at the position of the telescope or the white target on TheSky to determine the best way to get the
telecope pointed closer to zenith.
2. Hold SLEW and the appropriate direction button on the handpaddle to move the ’scope toward zenith.
3. Watch the TCS. When “APPROACHING LIMITS” stops blinking, you are clear. Release the handpaddle, and
resume normal operation. Note the telescope doesn’t resume normal movement until you release the
handpaddle.

Hardware limits
Although the software limits make this nearly impossible, you could hit the Hardware limits. The most common
reasons this occurs are slewing due north when taking off the cover, or not entering the date and time accurately on
startup. The telescope can also track into the hardware limits.
If you hit the hardware limits, the motors will shut off, and the green
light on the front of the blue box in the control room will be off. The
green light is the only sure way to tell.
To get out of the limits:
1. In the control room, push in red HALT MOTORS button.
2. Back in the dome, push front end of scope ~1” toward zenith by hand. Nothing will appear to happen, so don’t
push it again until you check for the green light!
3. In the control room, the green light should come on. If it does, release the red Halt Motors button. If not, go
back to the dome and push the ’scope another inch.
4. DO NOT move the telescope more than 3 - 4 inches (5 – 7 cm, about a hand span). If the green light doesn’t
come on, use the emergency contact list to get hold of someone for help! Do not leave the telescope sideways.
5. Restart the Telescope (page 8).
6. Report what happened. Someone will need to check the drive belts to be sure they are ok.
Other Problems

The tcs crashed

When the tcs crashes, it usually shows up as a short string of letters and numbers in the upper left corner of the display, and the handpaddle usually continues to work.

Follow the steps under Restarting on page 8 to get the telescope back to a working state.

If the crash is not caused by using initialization menu item 5 (see page 12), report the crash, preferably with a picture of the tcs screen and as much information about conditions as possible (those characters in the upper left are actually error codes.) If not using TheSky solves your problems, check your settings under Telescope → Setup and make sure they match the setup instructions beginning on page 24.

CCD connection Problems

The CCD must NOT be on before CCD soft is set up. If you turned it on before opening CCDSoft, shut the camera off, reboot the Windows computer (terminate the link with TheSky first!) then try again.

If the camera is not on when you try to connect, the old camera will give this error: The new camera may give this error, or it may give a “camera not found” error.

If the error persists after a reboot and after turning things on in the correct order, you'll need to use CCDOps to connect to the camera.

1. Terminate the link in TheSky and close all other programs. Make sure both cameras are off.

2. Open CCDOps (if it's not on the Desktop, go to Start → All Programs → SBIG → CCDOps)

3. Go to Misc → Graphics/Comm Setup…

4. Change the interface to USB for the USB imaging CCD or Parallel for the CCD on the SGS. If using the SGS, also set the LPT Port to LPT1 and Priority to High (see image, right.)

5. Turn the camera on.

6. Click the “EstLink” button (see image, left), press ctrl+k, OR go to Camera → Establish Comm Link.

7. If you still can’t establish a link, close CCDOps, reboot, open CCDOps, and turn on the camera. It should automatically try to connect when the camera is turned on. If not, try the step above again.

8. If you can’t establish a connection using CCDOps, you’ll have to report the problem.

9. Once you so establish a connection with CCDOps, you should be able to connect with CCDSoft. Close CCDOps before imaging so it doesn’t slow down communication with the camera.

One final note: you can run one camera with CCDSoft and one camera with CCDOps at the same time. However, there is no way to send light to both cameras at the same time.
The tcs crashed

When the tcs crashes, it usually shows up as a short string of letters and numbers in the upper left corner of the display, and the handpaddle usually continues to work.

Follow the steps under Restarting on page 8 to get the telescope back to a working state.

If the crash is not caused by using initialization menu item 5 (see page 12), report the crash, preferably with a picture of the tcs screen and as much information about conditions as possible (those characters in the upper left are actually error codes.) If not using TheSky solves your problems, check your settings under Telescope → Setup and make sure they match the setup instructions beginning on page 24.
Can’t focus the image

- Poor seeing conditions can cause objects to look out of focus. Higher magnification will make it worse. Having the spiral stair door open or not letting the telescope cool also makes it difficult to focus.
- Remember there is about a 2 second lag when changing direction using the handpaddle.
- Use Miscellaneous menu item 4 to return to a focus position that worked, or a position from the table in the appendix.
- If the focuser actually isn’t working, report the problem.

(Windows) PC Problems

The terminal you’re at doesn’t work, but the other one did

- Make sure the monitor is turned on.
- Check the main KVM box in the control room: both lights should be lit. If not, report the problem and reset the KVM: unplug the box that isn’t working, count to 5 and plug it back in.
- If resetting the KVM doesn’t work or you don’t want to play with it, work without the PC and report the problem and the steps you tried to fix it.

If the PC won’t boot:

- Check the white board for messages
- Make sure the power strip and monitor are on and the power cords are plugged in.
- Email astro-support to report that the computer won’t boot (use the lab Macs.) Be sure to specify the location of the computer, and which one it is.

If you can’t log in:

- Make sure the domain in the login screen is Kerberos realm
- Check the white board for messages.
- If you’re sure you’re typing everything in right and have the right domain, email astro-support from one of the lab computers.

TheSky won’t link to the tcs

- Make sure the tcs is on and the telescope is running
- Note any error messages and either email astro-labs or use the web form (see back cover) to report that you can’t link to the telescope.
- Use the info window in TheSky to get the RA and dec, then operate from the tcs (see Controlling the Telescope Without TheSky on page 16.) Note without the pointing model in TheSky you’ll probably need the handpaddle to center after every slew.
Appendix 1: History and Comparison with other Michigan Telescopes

Angell Hall

The Observatory on the roof of Angell Hall is the latest in a series of facilities at the University of Michigan to instruct students in observational astronomy. The first Students’ Observatory was constructed in the late 1870's close to the Detroit Observatory, and had a 6” refractor on an equatorial mount and a 3” transit circle. Optics for both were supplied by the Clarks. The building was torn down in 1923, and the mount for the refracting telescope was taken to South Africa to be used for site testing for the Lamont-Hussey Observatory. The 6” Clark lens later was used as a finder on the 27” Lamont refractor. The transit circle can still be seen in the Detroit Observatory.

During the 1920s a new observatory with two 24 foot diameter copper domes was built on the roof of Angell Hall. The southern dome housed a 10” refractor built by Warner and Swasey. The northern dome had a 15” Cassegrain reflector. Both were on equatorial mounts. These instruments were removed in the fall of 1993 during a complete renovation of Angell Hall.

University of Michigan astronomers have access to four other telescopes at observatories in Arizona and Chile. Here are the principal differences from the 0.4-m in how these other telescopes are controlled:

Hiltner 2.4-m telescope at MDM, Arizona

The 0.4-m is very much a smaller version of the 2.4-m at Michigan-DartmouthMIT Observatory. Everything is under computer control, and one never sees the telescope while one is observing, as the observer sits in a comfortable control room. The TCS display is different than that of the 0.4-m, but all the same information is presented on the display.

McGraw-Hill 1.3-m telescope at MDM, Arizona

With this telescope, one does most of the observing from the control room. However, to slew the telescope to a new object, one must go out into the dome and press the appropriate direction buttons to drive the telescope to a new position.

Curtis Schmidt telescope at Cerro Tololo, Chile

There is no TCS system for this telescope. All motion of the telescope and dome is by hand. One pushes some buttons to release the brakes on the telescope, and then physically moves the telescope around the sky while one is watching the pointers on the setting circles. The dome is also controlled from a handpaddle in the dome. The CCD camera is controlled, however, from an observing room underneath the telescope. Thus one has quite a bit of exercise going up and own the stairs during the night. What fun!

Magellan 6.5-m telescopes, Las Campanas, Chile

These twin telescope are completely computer controlled on alt-az mounts. The operator will move the telescope, make sure it is tracking and guiding, and keep the optics aligned. You (the observer) will provide him or her with a list of the objects to be observed during the night. The observer controls the CCD camera and filters, but will not control the telescope.
Appendix 2: Technical Information for the 0.4-m

Telescope Description

The current telescope was manufactured by DFM Engineering of Longmont, CO., and installed on Angell Hall in December, 1994. It is a 0.4-m diameter F/8 reflecting telescope with full Ritchey-Chretien optics (including field corrector). The reflecting optics are of low expansion material. The telescope has a demonstrated pointing accuracy of better than 30” rms and is completely computer controlled. The 18’ Ash Dome is controlled by the handpaddle.

Location

Latitude N 42d 16’ 37.8”
Longitude W 83d 44’ 23.88”

Optical Characteristics

Both primary and secondary mirrors are of Corning ULE. The field corrector is a two element design and is not currently installed since we don’t do any wide field observations.

The following information was provided by the manufacturer

<table>
<thead>
<tr>
<th>Primary</th>
<th>406.4 mm</th>
<th>127.0 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>primary mirror diameter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>hole diameter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>radius of curvature</td>
<td>2438.4 mm</td>
<td></td>
</tr>
<tr>
<td>focal length</td>
<td>1219.2 mm</td>
<td></td>
</tr>
<tr>
<td>conic constant</td>
<td>-1.1245</td>
<td></td>
</tr>
<tr>
<td>primary f ratio</td>
<td>F/3</td>
<td></td>
</tr>
<tr>
<td>Secondary</td>
<td></td>
<td></td>
</tr>
<tr>
<td>secondary mirror diameter</td>
<td>152.4 mm</td>
<td></td>
</tr>
<tr>
<td>radius of curvature</td>
<td>1197.1 mm</td>
<td></td>
</tr>
<tr>
<td>focal length</td>
<td>-598.4 mm</td>
<td></td>
</tr>
<tr>
<td>conic constant</td>
<td>-6.502</td>
<td></td>
</tr>
<tr>
<td>outside diameter of secondary baffle</td>
<td>202.4 mm</td>
<td>836.5 mm</td>
</tr>
<tr>
<td>primary-secondary separation</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System</th>
<th>3251.2 mm</th>
<th>63.4 ”/mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>system f ratio</td>
<td>F/8</td>
<td></td>
</tr>
<tr>
<td>focal length</td>
<td></td>
<td></td>
</tr>
<tr>
<td>plate scale</td>
<td>75 mm</td>
<td>1.32 deg</td>
</tr>
<tr>
<td>unvignetted field diameter</td>
<td>84.2 mm</td>
<td></td>
</tr>
<tr>
<td>back focal distance</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Eyepieces and Instruments for the 0.4-m**

The following eyepieces are available

<table>
<thead>
<tr>
<th>Focus length</th>
<th>Magnification (calculated)</th>
<th>Field of view</th>
<th>Approx focus position</th>
<th>Approx. focus w/ extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>35mm</td>
<td>91x</td>
<td>32'</td>
<td>1290</td>
<td>1794</td>
</tr>
<tr>
<td>25mm</td>
<td>128x</td>
<td>24'</td>
<td>1175</td>
<td>1675</td>
</tr>
<tr>
<td>15mm</td>
<td>213x</td>
<td>15'</td>
<td>1160</td>
<td>1695</td>
</tr>
<tr>
<td>7.5mm</td>
<td>427x</td>
<td>7'</td>
<td>1155</td>
<td>1690</td>
</tr>
<tr>
<td>USB CCD</td>
<td>NA</td>
<td>14.55x9.7''</td>
<td>1570</td>
<td>NA</td>
</tr>
<tr>
<td>SGS</td>
<td>NA</td>
<td>14.55x9.7''</td>
<td>1440</td>
<td>NA</td>
</tr>
</tbody>
</table>

The focus readings were noted at a temperature of 65 degrees F with the Sidewinder and corrective optics installed. At cooler temperatures the focus should be at lower numbers.

The eyepieces are stored in a black plastic storage container kept in the control desk in the dome. Please report misplaced eyepieces.

**Appendix 3: Filters**

Most eyepieces are 1.25” diameter and screw onto the base of the eyepiece.

There is a lunar filter in each eyepiece case that has a 13% transmission except the 0.4-m case, which has a polarizing filter. Additional filters are kept in a box in the locker. Please make sure filters go back into the correct box so others can find them:

<table>
<thead>
<tr>
<th>Set</th>
<th>Filter # and Color</th>
<th>Uses</th>
<th>% transmission, Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic set</td>
<td>#80A Blue</td>
<td>Great Red Spot, bands</td>
<td>Worth using</td>
</tr>
<tr>
<td></td>
<td>#58 Green</td>
<td>Martian polar caps and clouds, red features on Jupiter.</td>
<td>Best Martian detail</td>
</tr>
<tr>
<td></td>
<td>#25 Red</td>
<td>Mars, blue Jupiter &amp; Saturn clouds</td>
<td></td>
</tr>
<tr>
<td></td>
<td>#15 Yellow</td>
<td>Moon</td>
<td></td>
</tr>
<tr>
<td>Expansion set</td>
<td>#21 orange</td>
<td>Jovian bands</td>
<td>Worth using</td>
</tr>
<tr>
<td></td>
<td>#47 violet</td>
<td>Venus, Martian polar caps</td>
<td>Very dark</td>
</tr>
<tr>
<td></td>
<td>#11 yellow-green</td>
<td>Blue and red features on Jovian planets</td>
<td>Almost useless</td>
</tr>
<tr>
<td></td>
<td>#82 light blue</td>
<td>Jupiter’s atmosphere</td>
<td></td>
</tr>
<tr>
<td>Advanced set</td>
<td>#8 light yellow</td>
<td>Low contrast dust and ice details (atmospheres, comet dust tails)</td>
<td>83%</td>
</tr>
<tr>
<td></td>
<td>#23A light red</td>
<td>Enhances contrast for daylight/twilight planets</td>
<td>25% excellent for</td>
</tr>
<tr>
<td></td>
<td>#38A Deep Blue</td>
<td>Very bright objects</td>
<td>Mercury</td>
</tr>
<tr>
<td></td>
<td>#56 light green</td>
<td>Moon, Jovian &amp; Venusian atmospheres, Martian ice caps</td>
<td>17%</td>
</tr>
<tr>
<td>Filters in labs rooms</td>
<td>Skyglow Nebula/ ultrablock</td>
<td>Both reduce the glare from light pollution</td>
<td>53% worth using</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Light pollution too</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>bad for these to fix...</td>
</tr>
</tbody>
</table>
## Appendix 6: The Messier Objects and their coordinates

Epoch 2000. These are also library objects 1 - 110 (see page 17.)

<table>
<thead>
<tr>
<th>No</th>
<th>Name</th>
<th>m</th>
<th>Dist (kly)</th>
<th>Type</th>
<th>RA hh:mm.m</th>
<th>Dec dd:mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Crab nebula</td>
<td>8.4</td>
<td>6.3</td>
<td>SN remnant</td>
<td>05 : 34:30.3</td>
<td>+22 : 01</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>6.5</td>
<td>37.5</td>
<td>Globular cluster</td>
<td>21 : 33:26.9</td>
<td>-00 : 49</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>6.2</td>
<td>33.9</td>
<td>Globular cluster</td>
<td>13 : 42:10.4</td>
<td>+28 : 23</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>5.6</td>
<td>7.2</td>
<td>Globular cluster</td>
<td>16 : 23:36.0</td>
<td>-26 : 32</td>
</tr>
<tr>
<td>5</td>
<td>Butterfly cluster</td>
<td>5.6</td>
<td>24.5</td>
<td>Globular cluster</td>
<td>15 : 18:34.1</td>
<td>+02 : 05</td>
</tr>
<tr>
<td>6</td>
<td>Scorpion’s tail</td>
<td>4.2</td>
<td>1.6</td>
<td>Open cluster</td>
<td>17 : 40:35.9</td>
<td>-32 : 13</td>
</tr>
<tr>
<td>7</td>
<td>Lagoon nebula</td>
<td>3.3</td>
<td>0.8</td>
<td>Open cluster</td>
<td>17 : 53:18.2</td>
<td>-34 : 49</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>6.0</td>
<td>5.2</td>
<td>Diffuse nebula</td>
<td>18 : 04:04.6</td>
<td>-24 : 23</td>
</tr>
<tr>
<td>9</td>
<td>Wild duck cluster</td>
<td>7.7</td>
<td>25.8</td>
<td>Globular cluster</td>
<td>17 : 19:15.9</td>
<td>-18 : 31</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>6.6</td>
<td>14.3</td>
<td>Globular cluster</td>
<td>16 : 57:09.3</td>
<td>-04 : 06</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>6.3</td>
<td>6.0</td>
<td>Open cluster</td>
<td>18 : 51:03.2</td>
<td>-06 : 16</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>6.7</td>
<td>16.0</td>
<td>Globular cluster</td>
<td>16 : 47:14.3</td>
<td>-01 : 57</td>
</tr>
<tr>
<td>13</td>
<td>Hercules</td>
<td>5.8</td>
<td>25.1</td>
<td>Globular cluster</td>
<td>16 : 41:40.4</td>
<td>+36 : 28</td>
</tr>
<tr>
<td>14</td>
<td></td>
<td>7.6</td>
<td>30.3</td>
<td>Globular cluster</td>
<td>17 : 37:36.2</td>
<td>-03 : 15</td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>6.2</td>
<td>33.6</td>
<td>Globular cluster</td>
<td>21 : 29:57.9</td>
<td>+12 : 10</td>
</tr>
<tr>
<td>16</td>
<td></td>
<td>6.4</td>
<td>7.0</td>
<td>Open cluster</td>
<td>18 : 18:54.4</td>
<td>-13 : 47</td>
</tr>
<tr>
<td>17</td>
<td>Omega, swan, horseshoe</td>
<td>6.0</td>
<td>5.0</td>
<td>Diffuse nebula</td>
<td>18 : 20:47.8</td>
<td>-16 : 11</td>
</tr>
<tr>
<td>18</td>
<td>or lobster</td>
<td>7.5</td>
<td>4.9</td>
<td>Open cluster</td>
<td>18 : 20:05.6</td>
<td>-17 : 08</td>
</tr>
<tr>
<td>19</td>
<td></td>
<td>6.8</td>
<td>28.0</td>
<td>Globular cluster</td>
<td>17 : 02:37.5</td>
<td>-26 : 16</td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>6.9</td>
<td>16.0</td>
<td>Globular cluster</td>
<td>18 : 02:24.1</td>
<td>-23 : 02</td>
</tr>
<tr>
<td>21</td>
<td>Trifid</td>
<td>6.5</td>
<td>4.25</td>
<td>Open cluster</td>
<td>18 : 04:11.6</td>
<td>-22 : 30</td>
</tr>
<tr>
<td>22</td>
<td></td>
<td>5.1</td>
<td>10.4</td>
<td>Globular cluster</td>
<td>18 : 36:20.9</td>
<td>-23 : 54</td>
</tr>
<tr>
<td>23</td>
<td></td>
<td>6.9</td>
<td>2.15</td>
<td>Open cluster</td>
<td>17 : 56:58.2</td>
<td>-19 : 01</td>
</tr>
<tr>
<td>24</td>
<td>Delle Caustiche</td>
<td>4.6</td>
<td>10.0</td>
<td>Patch in Milky Way</td>
<td>18 : 15:49.0</td>
<td>-18 : 29</td>
</tr>
<tr>
<td>25</td>
<td>Dumbell</td>
<td>6.5</td>
<td>2.0</td>
<td>Open cluster</td>
<td>18 : 31:46.3</td>
<td>-19 : 15</td>
</tr>
<tr>
<td>26</td>
<td></td>
<td>8.0</td>
<td>5.0</td>
<td>Open cluster</td>
<td>18 : 45:15.9</td>
<td>-09 : 24</td>
</tr>
<tr>
<td>27</td>
<td></td>
<td>7.4</td>
<td>1.25</td>
<td>Planetary Nebula</td>
<td>19 : 59:34.6</td>
<td>+22 : 43</td>
</tr>
<tr>
<td>28</td>
<td></td>
<td>6.8</td>
<td>18.3</td>
<td>Globular cluster</td>
<td>18 : 24:31.6</td>
<td>-24 : 52</td>
</tr>
<tr>
<td>29</td>
<td>Andromeda Galaxy</td>
<td>7.1</td>
<td>4.0</td>
<td>Open cluster</td>
<td>20 : 24:08.1</td>
<td>+38 : 32</td>
</tr>
<tr>
<td>30</td>
<td></td>
<td>7.2</td>
<td>26.1</td>
<td>Globular cluster</td>
<td>21 : 40:23.0</td>
<td>+23 : 11</td>
</tr>
<tr>
<td>31</td>
<td>Andromeda satellite</td>
<td>3.4</td>
<td>2900</td>
<td>Sb galaxy</td>
<td>00 : 42:57.4</td>
<td>+41 : 16</td>
</tr>
<tr>
<td>32</td>
<td></td>
<td>8.1</td>
<td>2900</td>
<td>E2 galaxy</td>
<td>00 : 42:42.0</td>
<td>+40 : 52</td>
</tr>
<tr>
<td>33</td>
<td>Triangulum galaxy</td>
<td>5.7</td>
<td>3000</td>
<td>Sc galaxy</td>
<td>01 : 33:47.2</td>
<td>+30 : 39</td>
</tr>
<tr>
<td>34</td>
<td></td>
<td>5.5</td>
<td>1.4</td>
<td>Open cluster</td>
<td>02 : 42:13.5</td>
<td>+42 : 47</td>
</tr>
<tr>
<td>35</td>
<td></td>
<td>5.3</td>
<td>2.8</td>
<td>Open cluster</td>
<td>06 : 09:06.6</td>
<td>+24 : 20</td>
</tr>
<tr>
<td>36</td>
<td></td>
<td>6.3</td>
<td>5.1</td>
<td>Open cluster</td>
<td>05 : 36:26.2</td>
<td>+34 : 08</td>
</tr>
<tr>
<td>37</td>
<td>Winnecke 4</td>
<td>6.2</td>
<td>4.4</td>
<td>Open cluster</td>
<td>05 : 52:16.7</td>
<td>+32 : 33</td>
</tr>
<tr>
<td>38</td>
<td></td>
<td>7.4</td>
<td>4.2</td>
<td>Open cluster</td>
<td>05 : 28:45.7</td>
<td>+35 : 50</td>
</tr>
<tr>
<td>39</td>
<td></td>
<td>4.6</td>
<td>.825</td>
<td>Open cluster</td>
<td>21 : 31:42.0</td>
<td>+48 : 26</td>
</tr>
<tr>
<td>40</td>
<td></td>
<td>8.4</td>
<td>.51</td>
<td>Double Star</td>
<td>12 : 22:16.4</td>
<td>+58 : 05</td>
</tr>
<tr>
<td>41</td>
<td>Orion nebula</td>
<td>4.6</td>
<td>2.3</td>
<td>Open cluster</td>
<td>06 : 46:13.7</td>
<td>-20 : 44</td>
</tr>
<tr>
<td>42</td>
<td>De Mairan’s Nebula</td>
<td>4.0</td>
<td>1.6</td>
<td>Diffuse nebula</td>
<td>05 : 35:08.5</td>
<td>-05 : 27</td>
</tr>
<tr>
<td>43</td>
<td>Beehive Cluster, Praesepe</td>
<td>9.0</td>
<td>1.6</td>
<td>Diffuse nebula</td>
<td>05 : 35:30.7</td>
<td>-05 : 16</td>
</tr>
<tr>
<td>44</td>
<td></td>
<td>3.7</td>
<td>.577</td>
<td>Open cluster</td>
<td>08 : 40:08.5</td>
<td>+19 : 59</td>
</tr>
<tr>
<td>45</td>
<td>Pleiades</td>
<td>1.6</td>
<td>.38</td>
<td>Open cluster</td>
<td>03 : 46:48.4</td>
<td>+24 : 07</td>
</tr>
<tr>
<td>46</td>
<td></td>
<td>6.0</td>
<td>5.4</td>
<td>Open cluster</td>
<td>07 : 41:42.1</td>
<td>-14 : 49</td>
</tr>
<tr>
<td>47</td>
<td></td>
<td>5.2</td>
<td>1.6</td>
<td>Open cluster</td>
<td>07 : 36:38.8</td>
<td>-14 : 30</td>
</tr>
<tr>
<td>48</td>
<td></td>
<td>5.5</td>
<td>1.5</td>
<td>Open cluster</td>
<td>08 : 13:48.5</td>
<td>-05 : 48</td>
</tr>
<tr>
<td>49</td>
<td>Whirlpool Galaxy</td>
<td>8.4</td>
<td>60000</td>
<td>E4 galaxy</td>
<td>12 : 29:45.6</td>
<td>+08 : 00</td>
</tr>
<tr>
<td>50</td>
<td></td>
<td>6.3</td>
<td>3.0</td>
<td>Open cluster</td>
<td>07 : 02:44.0</td>
<td>-08 : 20</td>
</tr>
<tr>
<td>51</td>
<td></td>
<td>8.4</td>
<td>37000</td>
<td>Sc galaxy</td>
<td>13 : 29:52.7</td>
<td>+47 : 12</td>
</tr>
<tr>
<td>52</td>
<td></td>
<td>7.3</td>
<td>5.0</td>
<td>Open cluster</td>
<td>23 : 24:41.2</td>
<td>+61 : 35</td>
</tr>
<tr>
<td>53</td>
<td></td>
<td>7.6</td>
<td>58.0</td>
<td>Globular cluster</td>
<td>13 : 12:54.1</td>
<td>+18 : 10</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td>54</td>
<td>7.6</td>
<td>87.4</td>
<td>Globular cluster</td>
<td>18:55:14.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>6.3</td>
<td>17.3</td>
<td>Globular cluster</td>
<td>19:40:00.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>56</td>
<td>8.3</td>
<td>32.9</td>
<td>Globular cluster</td>
<td>19:16:37.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>Ring Nebula</td>
<td>8.8</td>
<td>2.3</td>
<td>Planetar y nebula</td>
<td>18:53:35.0</td>
<td></td>
</tr>
<tr>
<td>58</td>
<td>9.7</td>
<td>60000</td>
<td>Sbc galaxy</td>
<td>12:37:43.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>59</td>
<td>9.6</td>
<td>60000</td>
<td>E5 galaxy</td>
<td>12:42:01.9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>8.8</td>
<td>60000</td>
<td>E2 galaxy</td>
<td>12:43:37.8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>61</td>
<td>Sunflower galaxy</td>
<td>9.7</td>
<td>60000</td>
<td>SABbc galaxy</td>
<td>12:21:54.4</td>
<td></td>
</tr>
<tr>
<td>62</td>
<td>6.5</td>
<td>22.5</td>
<td>Sb galaxy</td>
<td>17:01:11.8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>63</td>
<td>8.6</td>
<td>37000</td>
<td>Globular cluster</td>
<td>13:15:52.8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>8.5</td>
<td>19000</td>
<td>Sb galaxy</td>
<td>12:56:42.8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td>Black eye galaxy</td>
<td>9.3</td>
<td>35000</td>
<td>Sa galaxy</td>
<td>11:18:57.3</td>
<td></td>
</tr>
<tr>
<td>66</td>
<td>8.9</td>
<td>35000</td>
<td>Sb galaxy</td>
<td>11:20:14.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>67</td>
<td>6.1</td>
<td>2.7</td>
<td>Open cluster</td>
<td>08:50:22.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>68</td>
<td>7.8</td>
<td>33.3</td>
<td>Globular cluster</td>
<td>12:39:28.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>69</td>
<td>Cetus A</td>
<td>7.6</td>
<td>29.7</td>
<td>Globular cluster</td>
<td>18:31:23.1</td>
<td></td>
</tr>
<tr>
<td>70</td>
<td>7.9</td>
<td>29.3</td>
<td>Globular cluster</td>
<td>18:43:15.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>71</td>
<td>8.2</td>
<td>13</td>
<td>Globular cluster</td>
<td>19:53:47.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>72</td>
<td>9.3</td>
<td>55.4</td>
<td>Globular cluster</td>
<td>20:53:37.8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>73</td>
<td>Little Dumbbell</td>
<td>9</td>
<td>2</td>
<td>Asterism</td>
<td>20:58:56.3</td>
<td></td>
</tr>
<tr>
<td>74</td>
<td>9.4</td>
<td>35000</td>
<td>Sc galaxy</td>
<td>01:36:42.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td>8.5</td>
<td>67.5</td>
<td>Globular cluster</td>
<td>20:06:05.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>76</td>
<td>10.1</td>
<td>3.4</td>
<td>Planetary nebula</td>
<td>01:42:18.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>77</td>
<td>Bode’s galaxy</td>
<td>8.9</td>
<td>60000</td>
<td>Sb galaxy</td>
<td>02:42:39.7</td>
<td></td>
</tr>
<tr>
<td>78</td>
<td>8.3</td>
<td>1.6</td>
<td>Diffuse nebula</td>
<td>05:46:41.9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>79</td>
<td>7.7</td>
<td>42.1</td>
<td>Globular cluster</td>
<td>05:24:08.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td>7.3</td>
<td>32.6</td>
<td>Globular cluster</td>
<td>16:17:02.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>81</td>
<td>Virgo A</td>
<td>9.1</td>
<td>60000</td>
<td>S0 galaxy</td>
<td>09:55:27.0</td>
<td></td>
</tr>
<tr>
<td>82</td>
<td>8.9</td>
<td>60000</td>
<td>S0 galaxy</td>
<td>12:25:25.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>83</td>
<td>8.9</td>
<td>60000</td>
<td>E0 galaxy</td>
<td>12:26:11.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>84</td>
<td>8.6</td>
<td>60000</td>
<td>E1 galaxy</td>
<td>12:30:32.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>85</td>
<td>9.6</td>
<td>60000</td>
<td>Sc galaxy</td>
<td>12:32:00.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>86</td>
<td>9.8</td>
<td>60000</td>
<td>E0 galaxy</td>
<td>12:35:40.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>87</td>
<td>9.5</td>
<td>60000</td>
<td>Sb galaxy</td>
<td>12:36:50.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>88</td>
<td>10.2</td>
<td>60000</td>
<td>SBB galaxy</td>
<td>12:35:26.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>89</td>
<td>6.4</td>
<td>26.7</td>
<td>Globular cluster</td>
<td>17:17:06.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>Owl nebula</td>
<td>9.9</td>
<td>2.6</td>
<td>Planetary nebula</td>
<td>11:14:48.0</td>
<td></td>
</tr>
<tr>
<td>91</td>
<td>10.1</td>
<td>60000</td>
<td>Sb galaxy</td>
<td>12:13:47.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>92</td>
<td>9.9</td>
<td>60000</td>
<td>Sc galaxy</td>
<td>12:18:49.8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>93</td>
<td>Sombrero galaxy</td>
<td>9.3</td>
<td>60000</td>
<td>Sc galaxy</td>
<td>12:22:55.1</td>
<td></td>
</tr>
<tr>
<td>94</td>
<td>Pinwheel galaxy</td>
<td>7.9</td>
<td>27000</td>
<td>Sc galaxy</td>
<td>14:03:11.8</td>
<td></td>
</tr>
<tr>
<td>95</td>
<td>10.5</td>
<td>12264</td>
<td>Spiral galaxy</td>
<td>15:06:29.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96</td>
<td>7.4</td>
<td>8.5</td>
<td>Open cluster</td>
<td>01:33:27.9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>97</td>
<td>8.0</td>
<td>50000</td>
<td>Sa galaxy</td>
<td>12:39:59.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>98</td>
<td>10.1</td>
<td>60000</td>
<td>Sb galaxy</td>
<td>12:13:47.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>99</td>
<td>9.9</td>
<td>60000</td>
<td>Sc galaxy</td>
<td>12:18:49.8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>9.3</td>
<td>60000</td>
<td>Sc galaxy</td>
<td>12:22:55.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>Sombrero galaxy</td>
<td>9.3</td>
<td>38000</td>
<td>E1 galaxy</td>
<td>10:47:49.8</td>
<td></td>
</tr>
<tr>
<td>102</td>
<td>8.4</td>
<td>25000</td>
<td>Sb galaxy</td>
<td>12:18:57.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>103</td>
<td>7.9</td>
<td>20.9</td>
<td>Globular Cluster</td>
<td>16:32:32.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>104</td>
<td>10</td>
<td>45000</td>
<td>Sc galaxy</td>
<td>11:11:32.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>105</td>
<td>E6 galaxy</td>
<td>9.8</td>
<td>55000</td>
<td>Sbc galaxy</td>
<td>11:57:36.3</td>
<td></td>
</tr>
<tr>
<td>106</td>
<td>8.5</td>
<td>2900</td>
<td>E6 galaxy</td>
<td>00:40:22.2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix 7: Operator’s Exam

Before you can officially become a telescope operator and bring people up to the observatory, you must pass an operator’s exam. During the exam, you will be asked to set up the 0.4-m for observing and shut it down again. You will also have to solve a couple of the following problems:

1. What to do if the power goes out while you have a class in the dome.
2. The dome won’t rotate. Diagnose why and what to do.
3. The dome upper shutter won’t close. Diagnose why and what to do.
4. The dome lower shutter won’t close. Diagnose why and what to do.
5. The telescope isn’t tracking. Diagnose why and what to do.
6. The telescope won’t slew to the next object: diagnose why it won’t move and how to fix it.
7. The telescope ran into the software limits. How do you know which limits and how do you get it out?
8. The telescope ran into the hardware limits. How do you know which limits and how do you get it out?
9. The PC won’t send coordinates to the tcs. How do you operate the telescope?
10. There is nothing visible in the eyepiece. What do you do?
11. The target is not in the eyepiece, though it was a few minutes ago. What happened and how do you fix it? (Alternatively, someone leans on the telescope – what do you do?)

In addition, (and depending on what you do in the observatory) you may be asked to set up a C8 for nighttime or solar observing and put it away again, or set up and take an image with the CCD camera.
# Index

0

0.4-m.......................................................... 51
Description.................................................. 51
eyeepieces.................................................. 52
Focus position................................................. 52
Optics........................................................ 51

A
Aligning the spectrograph.................................. 36
Aligning the Telescope........................................ 6
APPROACHING LIMITS..................................... 46
autoguider...................................................... 31, 33, 35, 36
AUX TRACK.................................................... 4, 13, 16
auxiliary tracking rates
  auxiliary..................................................... 13

B
blue box......................................................... 4, 8, 12, 14, 16, 46
boot.............................................................. 49
box.............................................................. 23

C
CCD........................................................ 9, 10, 11, 27, 28, 30, 33, 35, 50, 55
  parallel...................................................... 9, 11, 35
USB............................................................ 9, 52
CCDOps......................................................... 47
CCDSof ...................................................... 27, 32, 33, 34
AutoSave .................................................... 29, 31
Camera setup............................................... 28
Filter Wheel.................................................. 28, 31
preferences.................................................. 27
setup........................................................ 27
Vertical N binning.......................................... 28, 31
Closing the Dome ........................................... 7
drop out shutter............................................ 7
upper shutter.............................................. 7
Control Room shut down:................................. 7
Controlling the Telescope Without TheSky.......... 8
Controlling the TheSky.................................... 17
Controlling the telescope................................ 21
dark
  coordinates................................................ 13, 17
crosshair...................................................... 42
c D
Dark Theme................................................... 22
date .................................................................. 4, 15
Description.................................................. 51
Display Settings............................................. 22
Dome......................................................... 16, 37
closing......................................................... 39
opening......................................................... 38
rotation......................................................... 37
won't open.................................................... 38
won't rotate................................................... 37
won't close.................................................... 39

Dome Handpaddle Operations
  Dome rotation............................................. 19
  Dome Opening............................................ 5
  Drop out shutter......................................... 5
  upper shutter............................................. 5

E
Exam........................................................ 55
eyepiece...................................................... 9, 10, 18, 19, 34, 52, 55
Eyepieces..................................................... 52

F
Filters.......................................................... 52
First Time Setup.......................................... 22
focus......................................................... 13, 14, 15, 18, 19, 34, 36, 49, 52
G
Grating......................................................... 35

H
handpaddle6, 7, 14, 15, 16, 18, 19, 21, 34, 36, 45, 46, 47, 48, 49, 50, 51
Handpaddle Operations................................ 18
  focus....................................................... 18
  moving the telescope................................. 19
date and time ................................................................. 15
focus .............................................................................. 15
library ........................................................................... 13, 17
Manual entry of coordinates ........................................... 13, 17
overview of the system ................................................... 12
set offset ......................................................................... 13, 18
Setting the rates ............................................................. 16
starhopping ................................................................. 13, 18
stop .................................................................................. 14
tcs crash ................................................................. 47, 48
tcs display ....................................................................... 6, 12
tcs overview .................................................................. 12
Telescope Control System .............................................. 4
Telescope Doesn’t Move .................................................... 45
Telescope doesn’t slew ..................................................... 44
Telescope Motions
  doesn’t move ................................................................. 45
doesn’t slew ................................................................. 44
handpaddle problems .................................................... 45
not tracking ................................................................. 43
Telescope pointing
  nothing visible ............................................................ 6, 41
Telescope Pointing Problems ........................................... 40
Temperature ..................................................................... 30, 32, 34
terminal doesn’t work .................................................... 30, 32
The Telescope Control System ........................................ 12
TheSky ................................................................. 4, 7, 8, 15, 20, 21, 24, 25, 27, 30, 32, 46, 49
  Appearance .................................................................. 20
crosshair ................................................................. 42
find .............................................................................. 21
link .............................................................................. 20
send coordinates .......................................................... 21
telescope set-up ............................................................ 24
TheSky - setting up the telescope .................................... 24
time .............................................................................. 4, 15
TPoint ................................................................. 4, 15, 17, 20, 21, 25
track rates ...................................................................... 7, 13, 16
tracking ................................................................. 7, 13, 14, 16, 43, 46
trouble .......................................................................... 59
dome ................................................................. 37
dome closing ............................................................... 39
dome opening .............................................................. 38
dome rotation .............................................................. 37
focus .............................................................................. 49
handpaddle ................................................................. 45
limits ............................................................................. 46
moving ........................................................................... 46
nothing visible ............................................................. 6, 41
slewing .......................................................................... 44
target not visible ........................................................... 40
tcs ................................................................................ 47, 48
telescope motions ......................................................... 43
telescope pointing .......................................................... 40
theSky .......................................................................... 42, 49
tracking .......................................................................... 43
Windows PC ................................................................. 49
Troubleshooting ............................................................. 37
U
USB CCD ................................................................. 9, 10, 11, 28, 30, 33
UT .............................................................................. 15
W
Web Browser home page .............................................. 23
Windows ................................................................. 4, 49
boot problems ............................................................. 49
log in ............................................................................ 49
telescope link .............................................................. 49
teminal problem ........................................................... 49
Windows computer ......................................................... 22
Reporting Trouble

There are 3 ways to report trouble:

Log in to [http://request.umich.edu/astronomy/labs](http://request.umich.edu/astronomy/labs) using your uniqname and Kerberos password.

Send email to astro-labs@umich.edu (you must use your uniqname@umich.edu email to use this system)

Call one of the numbers on the phone list on the bulletin board in the control room. Home numbers are listed for emergencies (e.g. the telescope has stopped responding and you can’t figure out why)

To get computer help,

Fill out the form at [http://cats.ssu.lsa.umich.edu/helpform.asp](http://cats.ssu.lsa.umich.edu/helpform.asp)

Or email astro-support@umich.edu. If you send an email, make sure you include all the necessary information about the computer.

You should not leave until you have spoken to somebody if:

You cannot get the dome closed

You cannot get the telescope upright

You had to call 911 (unless you have to evacuate the building, accompany someone to the hospital, etc. Please contact someone ASAP though. We don’t want to find out about an accident from the evening news!)